CONTENTS

Preface ix
  Purpose ix
  Audience ix
  Organization x
  Related documentation x
  Product naming conventions xi
  Conventions xii
  Documentation and support xiii
  Documentation feedback xiii

PART I Cisco Unified Mobile Agent 1

CHAPTER 1 Introduction to Cisco Unified Mobile Agent for Unified CCE/Unified CCH 3
  Cisco Unified Mobile Agent Description 3
    Unified Mobile Agent extends Unified CCE/Unified CCH capabilities 5
    Unified Mobile Agent Provides Agent Login Flexibility 5
    Connection modes 5
      Call by Call 6
      Nailed Connections 7
        Connect Tone 8
      Agent Greeting and Whisper Announcement 8
        Agent Greeting 8
        Whisper Announcement 9
    Feature Requirements 9
      Hardware and software requirements 9
      Phone Requirements 10
      Conference Requirements 10
CHAPTER 2 System Configuration for Unified Mobile Agent

Summary of Unified Mobile Agent System Configuration Tasks

Unified Mobile Agent performance and optimization

Unified CM CTI Port Configuration and Mapping for Unified Mobile Agent

Music on Hold Design

Configure Unified CM CTI Port Pools for Unified Mobile Agent

Map Local and Remote CTI Ports with Peripheral Gateway User

Create Agent-Targeting Rules for LCP Ports

Maximum Call Duration Timer Configuration

Configure Maximum Call Duration Timer

Agent Desk Setting Configuration for Unified Mobile Agent

Configure Agent Desk Settings with Configuration Manager

Device configuration for Unified Mobile Agent

Cisco CTI OS Configuration for Unified Mobile Agent

CTI OS Installation and Unified Mobile Agent

Call Delivery Mode and Agent Profiles
Prevent Duplicate Logins to the Same AgentID 29
Media Termination Points Configuration 29
Configure Media Termination Points in Unified CM 30
   Add MTP Resources to Unified CM 30
   Configure Media Termination Point Resources in Unified CM 31
   Associate Media Resource Group List with Device Pools 32
   Quarantine Unified CM Software-Based Resources 32
   Insert MTPs 32
   Enable Call Progress Tones for Agent-Initiated Calls 33
   Verify MTP Resource Utilization 33
   Enabled Connect Tone Feature 33
   Enable Mobile Agent Connect Tone 34

PART II
Unified Mobile Agent in your contact center 35
   Overview 35

CHAPTER 3
Important Considerations 37
   Before you begin 37

CHAPTER 4
Unified Mobile Agent for agents 39
   CTI OS Agent Desktop 39
      Log In to CTI OS Agent Desktop 40
      Verify Login 41
      Enable Ringtone 41
      Enable Ready State 42
      Initiate a Call 42
      Transfer a Call 43
      Conference a call 43
      CRM Desktop Integration Through Unified CCE Through CTI OS 44
   Cisco Agent Desktop 44
      Log in to Cisco Agent Desktop 44
      Verify login to Cisco Agent Desktop 46
      Enable Ready state 46
      Initiate a call 46
      Transfer a call 47
Configure remote agent with analog phone at central office site 71
Agent's home configuration and setup 72
Example remote connection process 72
Remote agent with analog phone network requirements checklist 73
Remote agent with analog phone considerations 73

CHAPTER 9 Remote Agent user information 75
CTI Toolkit and CAD desktops 76
CTI Toolkit Agent Desktop FAQ 76
CAD desktop FAQ 78
Installation and configuration checklists 81
Remote Agent with IP phone components checklist 81
Remote Agent with analog phone components checklist 82
Hardware installation and configuration 82

CHAPTER 10 Troubleshooting Unified CCE Remote Agent Option 83
Caveats and limitations 83
Agent limitations 83
Supervisor limitations 84
Network limitations 84
Security limitations 85
Reporting limitations 85

CHAPTER 11 Sample Cisco IOS configuration for analog FXO to PRI gateway 87
Preface

• Purpose, page ix
• Audience, page ix
• Organization, page x
• Related documentation, page x
• Product naming conventions, page xi
• Conventions, page xii
• Documentation and support, page xiii
• Documentation feedback, page xiii

Purpose

This guide provides an overview of Cisco Unified Mobile Agent (Unified Mobile Agent), Unified Mobile Agent call flow information, configuration tasks, and step-by-step installation instructions for using the Cisco Unified Mobile Agent feature for Cisco Unified Contact Center Enterprise (Unified CCE) and Unified Contact Center Hosted (Unified CCH).

For ease of use, the guide separates system configuration instructions and troubleshooting information from task-related instructions for supervisors and agents using Unified Mobile Agent.

Unified Mobile Agent enables an agent using any PSTN phone and a broadband VPN connection (for agent desktop communications) to function just like a Unified CCE agent sitting in a formal call center and using a Cisco IP Phone monitored and controlled by Cisco Unified Communications Manager (Unified CM) JTAPI.

If you are upgrading to 9.0(1) and are planning to configure a Unified Mobile Agent to use an analog phone or an IP Phone without Cisco Business Ready Teleworker set up, use the Unified Mobile Agent Option. However, if you are planning to configure a Mobile Agent to use the deployment option of IP Phone with Cisco Business Ready Teleworker set up, use Remote Agent.

Audience

This document is intended for the administrator responsible for Unified Mobile Agent configuration, and for contact center supervisors and agents using Unified Mobile Agent to handle calls.
This guide refers to *product as a whole* by their new name. It refers to *components and utilities* by the names that appear in the user interface.

## Organization

The following table describes the information contained in the sections of this guide:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part 1: Cisco Unified Mobile Agent</strong></td>
<td>This section contains the following:</td>
</tr>
<tr>
<td></td>
<td>• Introduction to Cisco Unified Mobile Agent for Unified CCE/Unified CCH</td>
</tr>
<tr>
<td></td>
<td>• System Configuration for Unified Mobile Agent</td>
</tr>
<tr>
<td><strong>Part 2: Using Unified Mobile Agent in Your Contact Center</strong></td>
<td>This section contains the following:</td>
</tr>
<tr>
<td></td>
<td>• Overview</td>
</tr>
<tr>
<td></td>
<td>• Overview</td>
</tr>
<tr>
<td><strong>Part 3: Configuration and Troubleshooting for Remote Agent</strong></td>
<td>Overview</td>
</tr>
</tbody>
</table>

### Note

Read the *Cisco Unified Contact Center Enterprise 8.x Solution Reference Network Design (SRND)* guide before configuring Unified Mobile Agent.


## Related documentation

You can access documentation for Cisco Unified ICM/Contact Center Enterprise & Hosted, as well as related documentation, from Cisco.com at: [http://www.cisco.com/cisco/web/psa/default.html](http://www.cisco.com/cisco/web/psa/default.html).

Related documentation includes the documentation sets for Cisco CTI Object Server (CTI OS), Cisco Agent Desktop (CAD), Cisco Agent Desktop - Browser Edition (CAD-BE), Cisco Finesse, Cisco Unified Contact Center Management Portal, Cisco Unified Customer Voice Portal (Unified CVP), Cisco Unified IP IVR, Cisco Unified Intelligence Center, and Cisco Support Tools. The following list provides more information.

- For documentation for the preceding Cisco Unified Contact Center products, go to [http://www.cisco.com/cisco/web/psa/default.html](http://www.cisco.com/cisco/web/psa/default.html), click **Voice and Unified Communications**, then click **Customer Collaboration**, then click **Cisco Unified Contact Center Products** or **Cisco Unified Voice Self-Service Products**, and then click the product or option you are interested in.
Product naming conventions

In this release, the product names listed in the table below have changed. The New Name (long version) is reserved for the first instance of that product name and in all headings. The New Name (short version) is used for subsequent instances of the product name.

<table>
<thead>
<tr>
<th>Old Product Name</th>
<th>New Name (long version)</th>
<th>New Name (short version)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco IPCC Enterprise Edition</td>
<td>Cisco Unified Contact Center Enterprise</td>
<td>Unified CCE</td>
</tr>
<tr>
<td>Cisco System IPCC Enterprise Edition</td>
<td>Cisco Unified System Contact Center Enterprise</td>
<td>Unified SCCE</td>
</tr>
<tr>
<td>Cisco IPCC Hosted Edition</td>
<td>Cisco Unified Contact Center Hosted</td>
<td>Unified CCH</td>
</tr>
<tr>
<td>Cisco Intelligent Contact Management (ICM) Enterprise Edition</td>
<td>Cisco Unified Intelligent Contact Management Enterprise</td>
<td>Unified ICME</td>
</tr>
<tr>
<td>Cisco Intelligent Contact Management (ICM) Hosted Edition</td>
<td>Cisco Unified Intelligent Contact Management Hosted</td>
<td>Unified ICMH</td>
</tr>
</tbody>
</table>

Note: This document uses the naming conventions provided in each GUI, which means that in some cases the old product name is in use.
### Conventions

This manual uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
</table>
| **boldface** font | Boldface font is used to indicate commands, such as user entries, keys, buttons, and folder and submenu names. For example:  
- Choose **Edit > Find**.  
- Click **Finish**. |
| **italic** font | Italic font is used to indicate the following:  
- To introduce a new term; for example: A *skill group* is a collection of agents who share similar skills.  
- For emphasis; for example: Do *not* use the numerical naming convention.  
- A syntax value that the user must replace; for example: IF *(condition, true-value, false-value)*  
- A book title; for example: Refer to the *Cisco CRS Installation Guide*. |
| **window font** | Window font, such as Courier, is used for the following:  
- Text as it appears in code or that the window displays; for example:  
  `<html><title>Cisco Systems, Inc.</title></html>`  
- Navigational text when selecting menu options; for example:  
  `ICM Configuration Manager > Tools > Explorer Tools > Agent Explorer` |
| **< >** | Angle brackets are used to indicate the following:  
- For arguments where the context does not allow italic, such as ASCII output.  
- A character string that the user enters but that does not appear on the window such as a password. |
Documentation and support

For more information about obtaining documentation, submitting a service request, and gathering additional information, see the monthly *What's New in Cisco Product Documentation*, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the *What's New in Cisco Product Documentation* as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS Version 2.0.

Documentation feedback

You can provide comments about this document by sending email to the following address:

mailto: ccbu_docfeedback@cisco.com

We appreciate your comments.
Cisco Unified Mobile Agent

• Introduction to Cisco Unified Mobile Agent for Unified CCE/Unified CCH, page 3
• System Configuration for Unified Mobile Agent, page 21
CHAPTER 1

Introduction to Cisco Unified Mobile Agent for Unified CCE/Unified CCH

- Cisco Unified Mobile Agent Description, page 3
- Feature Requirements, page 9
- Supported Unified CCE/Unified CCH features, page 10
- Important Considerations, page 12
- Unified Mobile Agent call flows, page 14
- Unified Mobile Agent Reporting, page 20

Cisco Unified Mobile Agent Description

Cisco Unified Mobile Agent (Unified Mobile Agent) enables an agent using any PSTN phone and a broadband VPN connection (for agent desktop communications) to function just like an agent sitting in a formal call center and using a Cisco IP Phone that is monitored and controlled by Unified CM JTAPI.

Unified Mobile Agent for Unified CCE/Unified CCH supports call center agents using phones that are not directly controlled by Unified CCE/Unified CCH. You can physically locate a Mobile Agent:

- Outside the contact center, by using an analog phone in the home or a cell phone.
- By using an IP phone connection that is not CTI-controlled by Packaged CCE or by an associated Unified Communications Manager.
- By any voice endpoints on any ACD (including those on other Unified Communication Managers) that are reachable by a SIP trunk from the contact center Unified Communication Manager.

In addition, a Unified Mobile Agent can be available through different phone numbers at different times; the agent enters the phone number at login time. In other words, the agent can access Unified Mobile Agent using
any phone number, as long the agent can dial that number through the Unified Communications Manager dial plan.

**Figure 1: Agent at home using Unified Mobile Agent**

With Cisco Unified Mobile Agent, contact centers can:

- Add/enable temporary staff during seasonal high call volume who can be brought on line with reduced startup costs
- Provide agents with the flexibility to work from home with similar quality, function, performance, convenience, and security as are available in the corporate headquarters contact center
- Allow agents to use the device they are most comfortable with, which improves agent productivity, helps to retain agents, and reduces training costs
- Hire skilled employees where they live and integrate remote workers into geographically dispersed teams with access to equivalent corporate applications

The sections that follow highlight some of the benefits of Unified Mobile Agent, and describe its features.

**Related Topics**

- Important Considerations, on page 12
Unified Mobile Agent extends Unified CCE/Unified CCH capabilities

Prior to Unified Mobile Agent, Unified CCE/CCH used a JTAPI interface to Unified CM to connect customer calls arriving on a voice gateway to an agent's IP phone. Unified Mobile Agent extends the Unified CCE/Unified CCH architecture by enabling it to connect customer calls to an agent phone that is not controlled by Unified CCE/Unified CCH.

Unified Mobile Agent uses a pair of CTI ports that function as proxies for the Mobile Agent phone and the caller phone. Two CTI ports (local and remote) are required for every logged-in Mobile Agent, and the two CTI ports take the place of the Cisco IP Phone monitored and controlled by Unified CM JTAPI. The local CTI port DN is used by the agent at login and is where callers are routed when this agent is selected. The remote CTI port calls the agent either at login for a nailed (permanent) connection or upon being selected for a call by call connection.

Cisco Unified Contact Center functionality remains intact whether an agent is mobile or local:

- Mobile Agents have the same capabilities and functionality that local agents have.
- Mobile Agents do not need any specialized equipment; they can receive calls on an analog or cellular phone.
- Unified Mobile Agent supports Cisco CTI OS Agent Desktop, Cisco Agent Desktop (CAD), Cisco Agent Desktop-Browser Edition (CAD-BE), and Cisco Finesse.
- Mobile Agent activity is recorded in the same contact center reports as local agent activity.
- Mobile Agent CTI and application data uses the same security mechanisms as local agent data.

Unified Mobile Agent Provides Agent Login Flexibility

Agents, at various times, can be either local agents or a Mobile Agents, depending on how they log in.

Regardless of whether agents log in as local or Mobile Agents, the skill groups that they belongs to do not change. In addition, because agents are chosen by existing selection rules and not according to how they are connected, the same routing applies regardless of how the agents log in. In other words, if you want to use the scripting environment to control routing depending on whether agents are local or mobile, you need to assign the agents to different skill groups and design the script accordingly.

Related Topics

- Overview, on page 35

Connection modes

Cisco Unified Mobile Agent allows system administrators to configure agents to use either call by call dialing or a nailed connection, or the administrator can configure agents to choose a connection mode at login time.

Mobile Agents are defined as agents using phones not directly controlled by Unified CC, irrespective of their physical location. (The term local agent refers to an agent who uses a phone that is under control of Unified CC, irrespective of physical location.)

You can configure Mobile Agents using either of two delivery modes:

- Call by Call—In this mode, the Mobile Agent's phone is dialed for each incoming call. When the call ends, the Mobile Agent's phone is disconnected before being made ready for the next call.
Nailed Connection—In this mode, the agent is called at login time and the line stays connected through multiple customer calls.

The administrator can select the Agent chooses option, which allows an agent to select a call delivery mode at login.

**Call by Call**

In a call by call delivery mode, the Mobile Agent's phone is dialed for each incoming call. When the call ends, the Mobile Agent's phone disconnects before it is made ready for the next call.

The call by call call flow works as follows:

1. At login, the agent specifies an assigned extension for a CTI port.
2. A customer call arrives in the system and, through normal Unified ICM configuration and scripting, is queued for a skill group or an agent. (This is no different than existing processing for local agents.)
3. The system assigns an agent to the call. If the agent's Desk Setting is Unified Mobile Agent-enabled and configured for either call by call or Agent chooses mode, the router uses the extension of the agent's CTI port as a label.
4. The incoming call rings at the agent's CTI port. The JTAPI Gateway and PIM notice this but do not answer the call.
5. A call to the agent is initiated on another CTI port chosen from a preconfigured pool. If this call fails, Redirect on No Answer processing is initiated.

In call by call mode, the Answer Wait Time is 3 to 15 seconds longer than in a local agent inbound call scenario. Specify a Redirect on No Answer setting large enough to accommodate the extra processing time.

6. When the agent takes the remote phone off-hook to answer the call, the system directs the customer call to the agent's call media address and the agent's call to the customer's call media address.
7. When the call ends, both connections are terminated and the agent is ready to accept another call.

In call by call delivery mode, callers often perceive a longer ring time compared to nailed connection delivery mode. This is because callers hear the ringtone for the duration of the call flow; ringing stops only after the agent answers. From the Unified CCE reporting perspective, a Mobile Agent in call by call delivery mode has a longer Answer Wait Time for the same reason.

**Related Topics**

Configure Agent Desk Settings with Configuration Manager, on page 26
Nailed Connections

In *nailed connection* delivery mode, the agent is called once, at login, and the phone line remains connected through multiple customer calls. See the following figure.

*Figure 2: Nailed Connection Call Flow*

The nailed connection call flow works as follows:

1. At login, the agent specifies an assigned extension for a CTI port from a pool.
2. A call to the agent is initiated on another CTI port chosen from a preconfigured pool. The agent answers the call. (The agent must answer this setup call to complete the connection and finalize the login procedure.)
3. A customer's call arrives in the system and, through normal Packaged CCE configuration and scripting, is queued for a skill group or an agent. (This is no different than existing processing for local agents.)
4. The system assigns an agent to the call. If the agent's Desk Setting is Unified Mobile Agent-enabled and configured for either nailed connection or Agent chooses mode, the router uses the extension of the agent's CTI port as a label.
5. The incoming call rings at the agent's CTI port. The JTAPI Gateway and PIM notice this but does not answer the call.
6. The agent desktop indicates a call is ringing and the agent clicks **Answer**.
7. When the agent indicates that they will answer the phone, the system directs the customer call to the agent's call media address and the agent call to the customer's call media address.
8. When the call ends, the customer connection is terminated and the agent state is set to Ready.
Connect Tone

The Connect Tone feature in the nailed connection mode enables the system to play a tone to the Mobile Agent through the agent's headset to let the agent know when a new call is connected. In the nailed connection mode, you can configure an audible connect tone in addition to a call arrival notice (on the desktop only). Connect Tone is particularly useful when Auto Answer is enabled or the agent is an Outbound agent. Here are its features:

- An audible tone (two beeps) is sent to the Mobile Agent headset when the call to the nailed connection Mobile Agent is connected. It is a DTMF tone played by Unified CM and cannot be modified.
- The Connect Tone plays only when the nailed connection Mobile Agent receives a call, as in the following examples:
  - The agent receives a consultation call.
  - The agent receives an outbound call.
- The Connect Tone does not play when the nailed connection Mobile Agent initiates a call, as in the following examples:
  - The agent makes a call.
  - The agent makes the consultation call.
  - Outbound direct preview call is made.
  - Supervisor barge-in call is made.

Related Topics
Enable Mobile Agent Connect Tone, on page 34

Agent Greeting and Whisper Announcement

Note: You can use Agent Greeting for Mobile Agents only with parent/child deployments that are approved by Cisco Assessment-to-Quality (A2Q) with Design Mentoring Services (DMS).

Agent Greeting

You can use the Agent Greeting feature to record a message that plays automatically to callers when they connect to you. Your greeting message can welcome the caller, identify you, and include other useful information.

Limitations
The following limitations apply to the Agent Greeting feature for Mobile Agents.

- If a Mobile Agent hangs up when an Agent Greeting plays, the customer still hears the complete Agent Greeting before the call ends. This applies for both call by call and nailed-up calls.
In the Agent Greeting Call Type Report, this call does not appear as a failed agent greeting call.

- A supervisor cannot barge in when an Agent Greeting is playing.
- If a Peripheral Gateway (PG), JTAPI Gateway (JGW), or PIM failover occurs when an Agent Greeting plays for a Mobile Agent, the call fails.
- If a Mobile Agent hangs up when an Agent Greeting plays, the customer still hears the complete Agent Greeting before the call ends.

In the Agent Greeting Call Type Report, this call does not appear as a failed agent greeting call.

- If a Peripheral Gateway (PG), JTAPI Gateway (JGW), or PIM failover occurs when an Agent Greeting plays for a Mobile Agent, the call fails. This applies for both call-by-call and nailed-up calls.

For more information about Agent Greeting, see Agent Greeting requirements.

**Whisper Announcement**

With Whisper Announcement, agents can hear a brief prerecorded message just before they connect with each caller. The announcement plays only to the agent; the caller hears ringing (based on existing ringtone patterns) while the announcement plays. The announcement can contain information about the caller that helps the agent to prepare for the call; for example, language preference or customer status.

**Configuration Requirement**

For the Whisper Announcement feature for Unified Mobile Agents, you require a Media Termination Point (MTP) resource on an incoming SIP device.

For more information about Whisper Announcement, see Whisper Announcement requirements.

**Related Topics**

Media Termination Points Configuration, on page 29

**Feature Requirements**

**Hardware and software requirements**

Hardware and software requirements for the Unified Mobile Agent are identical to those of Unified CCE. For more information about limitations and scalability for Unified Mobile Agent, see the Hardware & System Software Specification (Bill of Materials) for Cisco Unified ICM/Contact Center Enterprise & Hosted, Release 9.0(1).
Phone Requirements

A Unified Mobile Agent can use an analog, digital, or IP phone to handle calls.

Conference Requirements

To use Agent Greeting for Mobile Agents, you must configure external conference-bridge (hardware) resources. To estimate the number of required resources, you can use the following formula:

\[
\text{Number of conference bridge resources} = \text{Mobile Agent call rate} \times \text{Average greeting time (in seconds)}
\]

For information about configuring external conference-bridge resources, see the dspfarm profile for conference configuration section in the sample configuration gateway, listed in Media Termination Points Configuration, on page 29.

For information about using Agent Greeting from CTI OS Agent Desktop, see the note in Verify Login, on page 41.

CTI Port Requirements

You require two CTI ports (local and remote) for every logged-in Mobile Agent.

Unified Mobile Agent uses Unified CM CTI Port as a proxy for the agent's phone. When this proxy is set up, whenever a Mobile Agent is selected to handle a customer call, the following happens:

- The call is directed to the CTI port extension.
- Unified CCE/Unified CCH, using the JTAPI Gateway, intercepts the call arriving on the CTI Port and directs Unified CM to connect the call to the Mobile Agent.

Unified Mobile Agent requires that maximum number of calls is set to 2 and busy trigger is set to 1.

For Unified Mobile Agent to work properly, you must configure two CTI ports:

- One port to serve as the agent's virtual extension.
- The other port to initiate calls to the agent.

One port is required per Mobile Agent. You must assign these CTI ports to the Unified ICME application. The ports are recognized by Unified ICME when receiving the Unified CM configuration.

Related Topics

Configure Unified CM CTI Port Pools for Unified Mobile Agent, on page 24

Supported Unified CCE/Unified CCH features

The following features are supported:

- Unified CCE support temporary uninstallation while preserving Mobile Agent data.

For more information about temporary uninstallation, see the Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted
• Mobile Agents can participate in outbound campaigns, but they must use a nailed-up connection for all outbound dialing modes.

• Unified Mobile Agent supports Redirect on No Answer (RONA). If the Mobile Agent fails to answer, the agent is made Not Ready, and the call is redirected to a RANA DN route point.

• Unified Mobile Agent supports silent monitoring in CTI OS and in Cisco Agent Desktop (CAD)

• Unified Mobile Agent supports the same call control capabilities as Unified CCE/Unified CCH (answer, hold, transfer, and so on). All call control is done through the CAD.

• Unified MA supports G.711A law, G.711U law, and G.729 codecs.

• There is no direct interaction between Unified Mobile Agent and multichannel applications. Email and Chat are IP applications that continue to operate normally, assuming the Mobile Agent has a desktop with enough bandwidth on the broadband connection to support them.

• Unified Mobile Agent supports Cisco Unified Customer Voice Portal (Unified CVP) and Cisco Unified IP-IVR (Unified IP IVR).

**Related Topics**

Silent Monitoring, on page 13

**Fault tolerance support**

Fault tolerance for the Unified Mobile Agent follows the behavior of Unified CCE/Unified CCH:

• The JTAPI Gateway, IPCC PIM, and CTI components record key events related to Unified Mobile Agent as part of their normal logging.

• As with standard Unified CC calls, if a Peripheral Gateway (PG) component such as the JTAPI Gateway fails, the phone call is not lost, but subsequent call control (transfer, conference, or hold) might not be possible after a failover. The Mobile Agent is notified of a failure (on the desktop), but they must log in again after a Unified CM or Unified ICM failure occurs.

• Where CTI data is delivered for screen pops, CTI data is preserved.

Unified Mobile Agent can experience many of the same failure cases as Unified CC:

• Side A/B failure

• IVR failure

• Unified CM failure

• CTI server failure

There are also some failure cases that are unique to Unified Mobile Agent:

• A situation where a Mobile Agent is using a cellular phone and the connection is dropped due to non-availability of a signal, is deemed as external failure. The agent must call back and log-in again.

• If a Mobile Agent's phone line disconnects while using nailed connection mode, the agent must log in again to receive new calls.
Important Considerations

Before you proceed, consider the following Unified Mobile Agent limitations and recommendations:

Failover

- During failover, if an agent in call by call mode answers an alerting call, the call can drop. This occurs because the media cannot be bridged when there is no active PG.

- During a prolonged Peripheral Gateway (PG) failover, if an agent takes call control action for a Unified Mobile Agent-to-Unified Mobile Agent call, the call can drop. This occurs because the activating PG might not have information for all agents and calls at that point.

- Unified CM failover causes a Mobile Agent call to be lost because call preservation on H.323 devices is not supported.

- If a call by call Mobile Agent initiates a call (including a supervisor call) and does not answer the remote leg of the call before PG failover, the call fails. The agent must disconnect the remote agent call leg and reinitiate the call.

Performance

- Mobile Agent call processing uses significantly more server resources and therefore reduces the maximum number of supported agents on both Unified CM and the Unified ICM Agent PG.

  For more information about sizing Mobile Agents, see the Cisco Unified Contact Center Enterprise 8.x Solution Reference Network Design (SRND).

  For more information about this release, see the Hardware & System Software Specification (Bill of Materials) for Cisco Unified ICM/Contact Center Enterprise & Hosted, Release 9.0(1).

- Because Unified Mobile Agent adds processing steps to Unified CCE/Unified CCH default functionality, Mobile Agents might experience some delay in screen popup windows.

- From a caller's perspective, the call by call delivery mode has a longer ring time compared with the nailed connection delivery mode. This is because Unified CCE/Unified CCH does not start to dial the Mobile Agent's phone number until after the call information is routed to the agent desktop. In addition, the customer call media stream is not connected to the agent until after the agent answers the phone. The caller hears a repeated ring tone while Unified CCE/Unified CCH makes these connections.

Codec

The codec settings on the Peripheral Gateway and Voice Gateway must match. Perform the following procedure:

1. Launch the Peripheral Gateway Setup.

2. In the Peripheral Gateway Component Properties, select the UCM PIM and click Edit.
3. In the CallManager Parameters section, select the appropriate codec from the Mobile Agent Codec drop-down list.

Figure 3: Mobile Agent Codec Selection

Silent Monitoring

Unified Mobile Agent provides the following silent monitoring support:

- Mobile Agent supports CTI OS server-based silent monitoring only. Unified CM-based silent monitoring is not supported.
- Unified Mobile Agent requires that caller and agent voice gateways be on separate devices if silent monitoring is to be used.
- Unified Mobile Agent does not support desktop monitoring.
- Whenever silent monitoring is used on Unified Mobile Agent, caller and agent voice gateways must be on separate devices. Similarly, if MTP is enabled when silent monitoring is used, MTP resources for caller and agent must also be on separate devices.

Note: For more information about Silent Monitoring requirements in a Unified Mobile Agent environment, see CTI OS System Manager's Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted.

Mobile Agent scalability

Mobile Agent scalability may be contingent on specific Unified CM versions. For more information, see the Cisco Unified Contact Center Enterprise 8.x Solution Reference Network Design (SRND).
Unsupported Features

The following is a list of unsupported features for Mobile Agent:

- Web Callback
- Blended Collaboration
- Unified CM-based Silent Monitoring

Unified Mobile Agent call flows

This section provides sample Unified Mobile Agent call flows for:

- Inbound calls
- Local consultation calls
- Remote consultation calls
- Remote conference calls

In all Unified Mobile Agent call flows, the JTAPI Gateway maintains the signaling association between the inbound and outbound calls and, if necessary, performs further operations on the call. JTAPI Gateway, however, does not terminate media; it uses CTI to deliver the customer call from the inbound gateway port to the outbound gateway port.

This means that a Mobile Agent must use an agent desktop application to log in, change agent state, log out, and perform call control.

About figures in this section

The figures in this section:

- Show a caller and a Mobile Agent in a cellular network. However, the same concepts apply whether the Mobile Agent is using an enterprise desk phone, an IP Phone spanning another Unified CM cluster, standard analog phone, or a third-party ACD phone.
- Focus solely on call media flow; a Mobile Agent must use a CTI Desktop with broadband access to perform agent state and call control.
- Show only a sampling of the call flows possible with Unified Mobile Agent.
Inbound call flow

The following figure shows an inbound call flow.

Figure 4: Mobile Agent inbound call flow

Note

Caller and Agent voice gateways can coreside on one device, except in deployments where Silent Monitoring is required.

The following describes an inbound call flow:

1. The Mobile Agent becomes available to answer calls by:
   - Logging in to the corporate domain using VPN over the ADSL/Cable connection
   - Launching the agent desktop interface and logging in to the CTI server with their remote phone information
   - Entering the Ready mode

2. A customer call arrives at the Unified CC.

3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile Agent.

4. The Router passes the call to the local CTI Port of a Mobile Agent.

5. The JTAPI Gateway places a call on a network CTI port to the agent's cell phone.

6. The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the call from the inbound (caller) gateway port to the outbound (agent) gateway port.
Local consult calls

The following figure shows a consult call flow between a Mobile Agent and a local agent.

Figure 5: Mobile Agent consult call flow

Note

Caller and Agent voice gateways can co-reside on one device, except in deployments where Silent Monitoring is required.

The following describes a local consult call flow:

1. The Mobile Agent becomes available to answer calls by:
   - Logging in to the corporate domain using VPN over the ADSL/Cable connection
   - Launching the agent desktop interface and logging in to the CTI server with their remote phone information
   - Entering the Ready mode

2. A customer call arrives at the Unified CC.

3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile Agent.

4. The Router passes the call to the local CTI Port of a Mobile Agent.

5. The JTAPI Gateway places Agent Connection Call 1 on a network CTI port to the agent's cell phone.

6. The Mobile Agent places the customer call on hold and consults a local Unified CCE/Unified CCH agent.
The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the call from the IP hard phone to the outbound gateway port.

Remote consult calls

The following figure shows a remote consult call flow between two Mobile Agents.

Figure 6: Mobile agent remote consult call flow

Note

Caller and Agent voice gateways can co-reside on one device, except in deployments where Silent Monitoring is required.

The following describes a remote consult call flow:

1. The Mobile Agent becomes available to answer calls by:
   - Logging in to the corporate domain using VPN over the ADSL/Cable connection
   - Launching the agent desktop interface and logging in to the CTI server with their remote phone information
   - Entering the Ready mode

2. A customer call arrives at the Unified CC.

3. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile Agent.

4. The Router passes the call to the local CTI Port of a Mobile Agent.
5 The JTAPI Gateway places Agent Connection Call 1 on a *network* CTI port to the agent's cell phone.
6 Mobile Agent 1 puts the customer call on hold and consults Mobile Agent 2.
7 The JTAPI Gateway uses the network CTI port of Mobile Agent 1 and the network CTI port of Mobile Agent 2 to stream the media for the call from the outbound gateway port on Agent Gateway 1 to the outbound gateway port on Agent Gateway 2.

**Remote conference calls**

The following figure shows a remote conference call flow between two Mobile Agents.

*Figure 7: Mobile Agent remote conference call flow*

---

**Note**

Caller and Agent voice gateways can co-reside on one device, except in deployments where Silent Monitoring is required.

The following describes a remote conference call flow:

1. The Mobile Agent becomes available to answer calls by:
   - Logging in to the corporate domain using VPN over the ADSL/Cable connection
• Launching the agent desktop interface and logging in to the CTI server with their remote phone information
• Entering the Ready mode

2 A customer call arrives at the Unified CC.
3 The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile Agent.
4 The Router passes the call to the local CTI Port of a Mobile Agent.
5 Unified CM redirects the media stream 1 from inbound gateway on the Caller Gateway to the conference bridge during call merging process.
6 The JTAPI Gateway uses local and network CTI ports of Mobile Agent 1 to loop the Media Stream 2 for the call from the outbound gateway port on the Agent Gateway 1 to the conference bridge.
7 The JTAPI Gateway uses local and network CTI ports of Mobile Agent 2 to loop the Media Stream 3 for the call from the outbound gateway port on the Agent Gateway 2 to the conference bridge.

Outbound Option call flow

The following figure shows a Outbound Option call flow between a customer and a Mobile Agent.

Note Unified Mobile Agent supports Outbound Option calls in nailed connection delivery mode only.
Note

Caller and Agent voice gateways can co-reside on one device, except in deployments where Silent Monitoring is required.

The following describes an Outbound Option call flow:

1. The Mobile Agent becomes available to answer calls by:
   - Logging in to the corporate domain using VPN over the ADSL/Cable connection
   - Launching the agent desktop interface and logging in to the CTI server with their remote phone information
   - Entering the Ready mode

2. The JTAPI Gateway creates a Mobile Agent class to manage local and network CTI ports for a Mobile Agent.

3. Outbound Option dials the customer number and, after reaching a live customer, the Dialer redirects the customer call to the local CTI Port of an Outbound Option Mobile Agent.

4. The JTAPI Gateway places a call on a network CTI port to the agent’s cell phone.

5. The JTAPI Gateway uses local and network CTI ports of the Mobile Agent to stream the media for the call from the inbound gateway port to the outbound gateway port.

Unified Mobile Agent Reporting

Unified Mobile Agent-specific call data is contained in the following Cisco Unified Intelligence Center reports: Agent Team Historical, Agent Real Time, and Agent Skill Group Historical. These "All Field" reports contain information in multiple fields that show what kind of call the agent is on (nonmobile, call by call, nailed connection) and the Unified Mobile Agent phone number.

Notes about Mobile Agents and reporting:

- The Mobile Agent must be logged in through the agent desktop for call data to be recorded in Unified CC reports.

- Service level for Mobile Agent calls might be different than local agent calls, because it takes longer to connect the call to the agent.

For example, a call by call Mobile Agent might have a longer Answer Wait Time Average than a local agent. This is because Unified CCE/Unified CCH does not start to dial the Mobile Agent phone number until after the call information is routed to the agent desktop. In addition, the customer call media stream is not connected to the agent until after the agent answers the phone.

For more information about Unified Mobile Agent fields in the database schema, see Database Schema Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted.
Chapter 2

System Configuration for Unified Mobile Agent

• Summary of Unified Mobile Agent System Configuration Tasks, page 21
• Unified Mobile Agent performance and optimization, page 22
• Unified CM CTI Port Configuration and Mapping for Unified Mobile Agent, page 22
• Maximum Call Duration Timer Configuration, page 26
• Agent Desk Setting Configuration for Unified Mobile Agent, page 26
• Device configuration for Unified Mobile Agent, page 28
• Cisco CTI OS Configuration for Unified Mobile Agent, page 28
• Media Termination Points Configuration, page 29
• Enabled Connect Tone Feature, page 33
• Enable Mobile Agent Connect Tone, page 34

Summary of Unified Mobile Agent System Configuration Tasks

This section describes the configuration tasks specific to Unified Mobile Agent configuration. It does not describe Unified CCE/Unified CCH. The following table describes system configuration tasks for Unified Mobile Agent.

Table 1: Unified Mobile Agent System Configuration Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Unified CM CTI Port pools</td>
<td>Unified CM CTI Port Configuration and Mapping for Unified Mobile Agent, on page 22</td>
</tr>
</tbody>
</table>
Unified Mobile Agent performance and optimization

Unified Mobile Agent is resource-intensive. Because it essentially uses two CTI ports for each Mobile Agent, you might find that your system's call capacity level will be lower.

For more information about configuring Unified Mobile Agent to maximize performance, see this release's version of the following documents:

- **Hardware & System Software Specification (Bill of Materials) for Cisco Unified ICM/Contact Center Enterprise & Hosted, Release 9.0(1)**
- **Cisco Unified Contact Center Enterprise 8.x Solution Reference Network Design**

Unified CM CTI Port Configuration and Mapping for Unified Mobile Agent

This section describes the CTI Port Pool configuration tasks specific to Mobile Agent Option configuration. It does not discuss installation or configuration of Unified CCE.

For more information about installing and configuring Unified CM with Unified CCE, see **Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted**.

Unified Mobile Agent must have two CTI ports configured on Unified CM:

- A *local* CTI port, which Unified Mobile Agent uses as the agent's virtual extension
- A *remote* CTI port, which Unified Mobile Agent uses to initiate a call to the Mobile Agent's phone

**Naming Conventions for Local and Network Ports**

- The local port must begin with the string LCP.
- The remote port must begin with the string RCP.
- The remaining characters in the device names for the LCP and RCP pair must match. For example an LCP port named LCP0000 has a corresponding RCP port named RCP0000.
• Although not required, for best practices, use the following naming convention:
  ◦ For a local CTI Port pool name, configure a name in the format LCP:xxxxFyyyy, where LCP identifies a local CTI Port Pool, xxxx is the peripheral ID for the Unified CM PIM, and yyyy is the number of local CTI Port.
    Example: LCP5000F0000 represents CTI Port: 0 in a local CTI Port pool for the Unified CM PIM with the peripheral ID 5000.
  ◦ For a network CTI Port pool name, use the same format, except substitute RCP as the first three characters.

  Note: While you do not require a naming convention, the substrings identifying the Unified CM PIM peripheral ID and the CTI Port must match for each local/network pair.

CTI Port configuration consists of the following steps:
1. Add the CTI port as you would for an IP Phone.
2. Use the naming convention described above to map the local and network CTI ports.

  Note: Each local CTI port must have a corresponding network CTI port.

3. Add a directory number for the local CTI port (that is, the agent's virtual extension).
4. Map the local and network CTI ports with the PG user.

**Music on Hold Design**

If you want callers to hear music when a Mobile Agent places the caller on hold, you must assign Music on Hold (MoH) resources to the ingress voice gateway or trunk that is connected to the caller (as you do with traditional agents). In this case, the user or network audio source is specified on the local CTI port configuration. Similarly, if a Mobile Agent must hear music when the system puts the agent on hold, you must assign MoH resources to the ingress voice gateway or trunk that is connected to the Mobile Agent. In this case, the user or network audio source is specified on the remote CTI port configuration.

Cisco recommends that you not assign MoH resources to local ports and remote CTI ports, because it might affect the system performance. If you have Agent Greeting for Mobile Agents, Cisco strongly recommends that you do not assign MoH resources to local and remote CTI ports.

If a remote Mobile Agent calls over a nailed connection and if there is no active call to the agent, the agent is put on hold. In general, Cisco recommends that you enable MoH to the Mobile Agent phone for nailed connection calls. If MoH resources are an issue, consider multicast MoH services.

If a remote Mobile Agent calls over a nailed connection, and if MoH is disabled, the hold tone plays to the agent phone during the hold time. This depends on the call processing agent that controls the Mobile Agent remote phone. For Unified CM, the hold tone is enabled by default (it is similar to the Mobile Agent connect tone). Because the hold tone is similar to the connect tone, it is difficult for the agent to identify if a call arrived from listening to the Mobile Agent connect tone. The hold tone prevents the agent from hearing the connect tone.
Therefore, Cisco recommends that you disable the hold tone by changing the setting of the Tone on Hold Timer service parameter to 0. For more information about setting this parameter, see the Unified CM product documentation available at: http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html.

**Configure Unified CM CTI Port Pools for Unified Mobile Agent**

Perform the following steps to configure CTI Ports.

**Procedure**

**Step 1** In Unified CM Administration, select **Device > Phone**.

**Step 2** Click **Add a New Phone**.

**Step 3** From Phone Type, select **CTI Port**.

**Step 4** Click **Next**.

**Step 5** In Device Name, enter a unique name for the local CTI Port pool name; click **OK** when finished.

Using the naming convention format LCPxxxxyyyy:

- LCP identifies the CTI Port as a local device.
- xxxx is the peripheral ID for the Unified CM PIM.
- yyyy is the local CTI Port.

The name LCP5000F0000 would represent CTI Port: 0 in a local CTI Port pool for the Unified CM PIM with the peripheral ID 5000.

The name LCP0000 represents the local port.

**Step 6** In Description, enter text that identifies the local CTI port.

**Step 7** Use the **Device Pool** drop-down list to choose the device pool to which you want to assign the network CTI port pool. (The device pool defines sets of common characteristics for devices.)

**Step 8** Click **Save**.

**Step 9** Highlight a record and select **Add a New DN**.

**Step 10** Add a unique directory number for the CTI port you just created.

**Step 11** In Maximum Number of Calls, enter 2.

**Step 12** In Busy Trigger, enter 1.

**Step 13** When finished, click **Save** and click **Close**.

**Step 14** Repeat the preceding steps to configure the network CTI port pool.

In Device Name, using the naming convention format RCPxxxxyyyy, where:

- RCP identifies the CTI port as the Remote CTI port where the call between the agent's remote device and the Unified CM Port is nailed up at agent login time.
- xxxx is the peripheral ID for the Unified CM PIM.
- yyyy is the network CTI port.

The name RCP5000F0000 represents CTI Port: 0 in a network CTI Port pool for the Unified CM PIM with the peripheral ID 5000.
Step 15  In Description, enter text that identifies the network CTI port pool.
Step 16  Use the Device Pool drop-down list to choose the device pool to which you want to assign the network CTI port pool. (The device pool defines sets of common characteristics for devices.)
Step 17  Click Save.
Step 18  Highlight a record and select Add a New DN.
Step 19  Add a unique directory number for the CTI port you just created.
Step 20  When finished, click Save, and click Close.

Map Local and Remote CTI Ports with Peripheral Gateway User

After you define the CTI Port pool, you must associate the CTI Ports with PG users.

Procedure

Step 1  In Unified CM Administration, select Application User.
Step 2  Select a username and associate ports with it.
Step 3  When finished, click Save, and then click Close.
Note  If CTI ports for Unified Mobile Agent are disassociated at the Unified CM while a Mobile Agent is on an active call, the call can drop.

Create Agent-Targeting Rules for LCP Ports

You must create agent-targeting rules for your LCP ports in order to log in as a mobile agent.

Procedure

Step 1  Open Configuration Manager.
Step 2  Within Configuration Manager, open the Agent Targeting Rule tool.
Step 3  On the Agent Targeting Rule tool screen, select your existing agent-targeting rules.
Step 4  In the Extension Ranges section, add the range of line numbers for the LCP ports that you are using for your mobile agents.

Example:
1000-2000

Step 5  Click Save and exit the tool.
Maximum Call Duration Timer Configuration

By default, Mobile Agents in nailed connection mode log out after 12 hours. This happens because a Unified CM Service Parameter—the Maximum Call Duration Timer—determines the amount of time an agent phone can remain in the Connected state after login.

If you anticipate that nailed connection agents in your Unified Mobile Agent deployment will be logged on longer than 12 hours, use the following instructions to either:

- Increase the Maximum Call Duration Timer setting.
- Disable the timer entirely.

Configure Maximum Call Duration Timer

Note

This procedure applies only to Unified Mobile Agent deployments where agents logged in to nailed connection mode are to remain connected longer than 12 hours. Also, if your Mobile Agent deployment uses intercluster trunks, you must perform the following steps on both local and network Unified CM clusters.

Procedure

Step 1 In Unified CM Administration, choose System > Service Parameters.
Step 2 In the Server drop-down list, choose a server.
Step 3 In the Service drop-down list, choose a server. The Service Parameters Configuration window appears.
Step 4 In the Cluster-wide Parameters section, specify a Maximum Call Duration Timer setting. The default is 720 minutes (12 hours); the maximum setting allowed is 35791 minutes.

Note To disable the timer, enter 0.
Step 5 Click Save.

Agent Desk Setting Configuration for Unified Mobile Agent

This section describes Agent Desk Settings you must modify to accommodate Unified Mobile Agent features.

You can configure Agent Desk Settings through the PCCE Administration tool.

Configure Agent Desk Settings with Configuration Manager

This section describes Agent Desk Settings configuration settings you should specify in Unified ICM Configuration Manager to accommodate Unified Mobile Agent features.
The following instructions describe how to configure one Agent Desk Setting. Repeat this process for each different Agent Desk Setting in your deployment.

**Procedure**

**Step 1** From the Unified ICM Configuration Manager, choose **Configure ICM > Enterprise > Agent Desk Settings List**.

The Unified ICM Agent Desk Settings List dialog box opens.

**Step 2** From the Unified CCE Administration, choose **Manage > Desk Settings**.

**Step 3** Click **Retrieve**.

**Step 4** Click **Add**.

**Step 5** Fill in the following Attributes tab information, making sure to include settings for the following fields and check boxes:

- **Ring no answer time.** The system allows a call to ring at the agent's station before redirecting the call. This can be from 1 to 120 seconds.
  
  **Note** If you use call by call mode, the answer wait time will be longer than in a local agent inbound call scenario, so specify a value in this field to accommodate the extra processing time.

- **Logout non-activity time.** The number of seconds of agent inactivity while in the not ready state before the system logs out the agent. A blank entry disables the timer.

- **Cisco Unified Mobile Agent** (check box). Enables the Mobile Agent feature so that the agent can log in remotely and take calls from any phone.

- **Mobile Agent mode.** Select how call connections are made to the Mobile Agent's phone:
  
  - **Agent chooses.** Agent selects call by call or nailed connection at login.
  
  - **Call by call.** Agent's phone is dialed for each incoming call. When a call ends, the connection is terminated before the agent is made ready for next call.
  
  - **Nailed connection.** Agent is called once, at login. The line stays connected through multiple customer calls.

**Step 6** Check the **Enable Mobile Agent** check box. This enables the Mobile Agent feature so that the agent can log in remotely and take calls from any phone.

**Step 7** Click **Save**.

**Note** For more information about configuring Agent Desk Settings in PCCE/Unified CCH, see *Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted*.

**Related Topics**

- Prevent Duplicate Logins to the Same AgentID, on page 29
Device configuration for Unified Mobile Agent

Use the Agent Targeting Rules (ATR) mechanism described in the Installation and Configuration Guide for Cisco Unified Contact Center Enterprise & Hosted to configure a device as you would for a phone, but using the LCP Port in place of the agent's phone extension.

Cisco CTI OS Configuration for Unified Mobile Agent

This section describes information about CTI OS configuration settings that you need to know after initial installation of a Mobile Agent-enabled CTI OS Server.

Note
For more information about installing and configuring CTI OS Server, see CTI OS System Manager's Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted.

CTI OS Installation and Unified Mobile Agent

Note
Running the CTI OS 7.x server installer is not the same as running CTI OS 7.x installer from the CTI OS bin directory.

To configure Mobile Agent, run the CTI OS 7.x server installer from your installation media. This first installer updates CTI OS server. Then run the CTI OS installer from the CTI OS bin directory. This second installer allows you to configure Mobile Agent. Use both installation procedures to configure any new feature made available in a maintenance release.

During the peripheral identification step of CTI OS Server installation:

1. Click Yes to stop the service and to acknowledge the license agreement.
2. Select CTIOS server from CTI OS Instance and click Edit.
3. Click Next to navigate to Peripheral Identifier.
4. Check the Enable Mobile Agent checkbox.
5. Select Nailed connection for Mobile agent mode. (It is the only call delivery mode supported.)
6. Click Save.

• The Unified Mobile Agent feature is enabled for the CTI Desktop (from the CTI OS bin directory).
• The call delivery mode (agent choose, call by call, nailed connection) is defined.
• The nailed connection call delivery mode is the only available mode defined.

Call Delivery Mode and Agent Profiles

• The call delivery mode selected during CTI OS Server installation enables CTI OS to send an agent profile to each desktop client for that mode.
• The call delivery mode the agent uses at login must match the mode that is configured for the agent in the Agent Desk Setting.
• Rerunning the CTI OS installation and selecting a different Mobile Agent mode overwrites the existing profile.
• You can add profiles manually using the CTI OS registry. For more information, refer to the CTI OS Developer’s Guide for Cisco Unified Contact Center Enterprise.

Prevent Duplicate Logins to the Same AgentID

In the default Installation, the CTI OS system does not prevent duplicate logins. If you want to change the default, you must make the following change in the Windows Registry for the key RejectIfAlreadyLoggedln.

Procedure

Step 1 On the CTI OS Server, open the Registry Editor (regedit.exe).
Step 2 Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ctios\CTIOS_<InstanceName>\ CTIOS1\ EnterpriseDesktopSettings\All Desktops\ Login \ConnectionProfiles \Name\<YourConnectionProfileName>\RejectIfAlreadyLoggedln . The Edit DWORD Value dialog box appears.
Step 3 In the Value data: field, enter 1 and click OK.
Step 4 Exit the Registry Editor to save the change, and reboot your computer.

Optionally, you can configure the CTI OS CTI Driver key IdleTimeout to the same value as the Unified ICM Agent Desk Settings Logout non-activity time value.

Related Topics

Configure Agent Desk Settings with Configuration Manager, on page 26

Media Termination Points Configuration

If you use SIP trunks, you must configure Media Termination Points (MTPs). You must also configure MTPs if you use TDM trunks to create an interface with service providers.

Additionally, MTPs are required for Mobile Agent call flows that involve a Cisco Unified Customer Voice Portal (CVP) solution. Because in DTMF signaling mode the Mobile Agent uses out-of-band signaling, whereas Unified CVP supports in-band signaling, the conversion from out-of-band to in-band signaling requires an MTP resource.

MTPs are available in the following forms, but not all are supported in Mobile Agent environments:

• Software-based MTPs in Cisco IOS gateways—It is recommended that you use these MTPs for Mobile Agent as they provide codec flexibility and better scalability compared with other MTP options. The following is a sample configuration on a gateway.

```
sccp local GigabitEthernet0/0
sccp ccm 10.10.10.31 identifier 1 priority 1 version 7.0
sccp ccm 10.10.10.131 identifier 2 priority 2 version 7.0
```
```plaintext
sccp
!
  sccp ccm group 1
  associate ccm 1 priority 1
  associate ccm 2 priority 2
  associate profile 3 register gw84xcode
  associate profile 1 register gw84conf
  associate profile 2 register gw84mtp

  dspfarm profile 3 transcode
  codec g729abr8
  codec g729ar8
  codec g711alaw
  codec g711ulaw
  codec g729r8
  codec g729br8
  maximum sessions 52
  associate application SCCP
!
  dspfarm profile 1 conference
  codec g729br8
  codec g729r8
  codec g729abr8
  codec g729ar8
  codec g711alaw
  codec g711ulaw
  maximum sessions 24
  associate application SCCP
!
  dspfarm profile 2 mtp
  codec g711ulaw
  maximum sessions software 500
  associate application SCCP
```

- Hardware-based MTPs in Cisco IOS gateways—These MTPs are supported. However, Cisco does not recommend them because of the extra cost, codec restrictions, and scalability constraints.

- Software-based MTPs using the Cisco IP Voice Media Streaming Application—These MTPs are not supported with Mobile Agents.

---

**Note**

Because Unified CM-based software MTPs are used implicitly, you must add a special configuration to avoid using them. Create a new Media Resource Group (MRG) as a place holder, and place the software MTPs in that MRG. For instructions, refer to the Unified CM help documentation.

---

**Configure Media Termination Points in Unified CM**

**Add MTP Resources to Unified CM**

Perform these steps to add media termination points (MTPs) to Unified CM.
Procedure

Step 1 In Unified CM Administration click Media Resources > Media Termination Point.
Step 2 Click Add New.
Step 3 Choose Cisco IOS Enhanced Software Media Termination Point from the Media Termination Point Type drop-down list.
Step 4 Enter an MTP name. This name must match the device name you chose in IOS. In the example in the previous section, the MTP was called gw84mtp, as from the config line: associate profile 2 gw84mtp.
Step 5 Choose the appropriate device pool.
Step 6 Click Save and then click Apply config.
Step 7 Navigate back to Media Termination Point and ensure the newly added MTP is listed as being registered with <Unified CM subscriber IP address> in the Status column.
Step 8 Repeat steps 1 through 7 for each sccp ccm group you configured on each of your gateways.

Configure Media Termination Point Resources in Unified CM

This section explains how to create media resource groups and media resource group lists.

Procedure

Step 1 Navigate to Media Resources > Media Resource Group in Unified CM Administration.
Step 2 Click Add New.
Step 3 Specify a name and description.
Step 4 From the Available Media Resources that you just created, move the those devices from the Available to the Selected list by clicking the down arrow. Ensure that you do not include Unified CM Software resources. For example, type anything that starts with ANN_, MTP_, or MOH_.
Step 5 Navigate to Media Resources > Media Resource Group List.
Step 6 Click Add New.
Step 7 Move the Media Resource Group you just created from the Available Media Resource Groups to the Selected Media Resource Groups.
Step 8 Click Save.
**Associate Media Resource Group List with Device Pools**

**Procedure**

**Step 1** Navigate to System > Device Pool and click on the device pool that contains the CTI ports for Mobile Agent. If there are multiple pools, perform the next step for each device pool that applies.

**Step 2** In the Media Resource Group List drop-down list, select the Media Resource Group List that you just created, click **Save** and then click **Apply config**.

---

**Quarantine Unified CM Software-Based Resources**

Because Unified CM-based software MTPs are used implicitly, you must add a special configuration to avoid using them. This, in effect, quarantines them.

**Procedure**

**Step 1** Create a new Media Resource Group (MRG) as a place holder.

**Step 2** Place the software MTPs in that MRG.
For further instructions, refer to the Unified CM help documentation.

---

**Insert MTPs**

If you use SIP trunks, you must configure MTPs. This also applies if you use TDM trunks to interact with service providers. Mobile Agent cannot use an MTP with codec pass through. When you configure the MTP, you must select No pass through. KPML is not supported with Mobile Agent.

**Procedure**

**Step 1** Log in to Unified CM Administration and select **Device > Trunk**.

**Step 2** Select the trunk on which you want to configure MTPs.

**Step 3** Depending on the scenario listed below, perform the corresponding step listed in the Description column. Note that if you configure Trunk Groups to dynamically insert MTPs, only the calls that require MTPs use them.

- If you want to always insert MTPs for inbound and outbound calls through a given trunk: In the Trunk Configuration settings, select the **Media Termination Point Required** check box.

- If you want to dynamically insert MTPs when Unified ICM detects media or signaling incompatibility between the caller and called endpoints: In the Trunk Group Configuration settings, in DTMF Signaling Method, select **RFC2833**.
Enable Call Progress Tones for Agent-Initiated Calls

**Procedure**

In order for an agent to hear call progress tones for agent initiated calls, additional configuration is required if **MTP Required** is not enabled. If instead you have dynamic MTP allocation by forcing mismatched DTMF settings, then the Unified CM should be configured to enable Early Offer.

For information on configuring the Unified CM, see the **Unified CM product documentation**. Ringback and other call progress tones are not generated by the Cisco Announcer, as is the case for regular phones and softphones. Instead, Mobile Agent relies on these tones being generated by the called party (and the early offer setting triggers these tones to be sent to the agent).

**Note** This selection does not affect MTP sizing for IP Phones and other endpoints that support RFC2833 signaling, as is the case for many Cisco phones (including the 6900 series and the 794x and 796x phones). For more information about supported phones, see the **Cisco Compatibility Matrix Wiki**.

Verify MTP Resource Utilization

Since Unified CM comes preconfigured with Software MTP resources, these resources may sometimes be used to provide MTP for Mobile Agent calls without proper configuration. Since we don't support the use of Unified CM based software MTP's, we explicitly quarantined them in the above section, Disabling Unified CM Based Software MTPs. To ensure that the new IOS-based MTP's are the ones being used for Mobile Agents, we recommend that you perform the following steps to verify that correct MTP's are used.

**Procedure**

---

**Step 1** Install the Unified CM Realtime monitoring tool. This tool can be downloaded under **Application > Plugins** within Unified CM Administration.

**Step 2** Place a call to a logged-in Mobile Agent.

**Step 3** Open the Unified CM Realtime monitoring tool and navigate to **System > Performance > Open Performance Monitoring**.

**Step 4** Expand the node(s) that are associated with your IOS-based MTP resources and choose **Cisco MTP Device**.

**Step 5** Double-click **Resources Active** and choose all of the available resources to monitor. This includes both IOS and Unified CM-based resources. Ensure that the only resources that are active during the Mobile Agent phone call are the IOS-based resources. Also, ensure that all UCM-based MTP resources are **not** active.

**Step 6** Repeat the previous step for each node that has MTP resources associated with it.

---

Enabled Connect Tone Feature

In a nailed connection, the system can play a tone to the Unified Mobile Agent through the agent headset to let the agent know when a new call is connected. In the default Installation, the Mobile Agent Connect Tone feature is disabled.
Enable Mobile Agent Connect Tone

If you require Unified Mobile Agent Connect Tone, you must make the following change in the Windows Registry for the key PlayMAConnectTone under the JTAPI GW PG registry entries.

Perform the following procedure to allow a Mobile Agent in the nailed connection mode to hear a tone when a new call is connected.

Procedure

**Step 1** On the PG machine, open the Registry Editor (regedit.exe).

**Step 2** Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc\ICM\icm7\PG\CurrentVersion\JGWS\jgw1\JGWData\Config\PlayMAConnectTone. The Edit DWORD Value dialog box appears.

**Step 3** In the Value data: field, enter 1 to enable Mobile Agent Connect Tone and click OK.

**Step 4** Exit the Registry Editor to save the change, and cycle the PG service.
PART II

Unified Mobile Agent in your contact center

• Overview, page 35
• Important Considerations, page 37
• Unified Mobile Agent for agents, page 39
• Unified Mobile Agent for supervisors, page 53

Overview

This section provides the following:

• Important information about Unified Mobile Agent features and functionality.
• Instructions for call processing for agents using the Cisco CTI OS Agent Desktop or the Cisco Agent Desktop.
• Instructions for call processing and agent management for supervisors using the Cisco CTI OS Supervisor Desktop or Cisco Agent Desktop Supervisor Desktop.

Note

This section describes tasks that are specific to interacting with Unified Mobile Agent. For more information about using these desktops, see the Cisco CTI OS documentation (located on the Cisco web page: http://www.cisco.com/en/US/products/sw/custcosw/ps14/products_user_guide_list.html) and the Cisco Agent Desktop documentation (located on the Cisco web page: http://www.cisco.com/en/US/products/sw/custcosw/ps427/products_user_guide_list.html).
For more information about the desktop operating system and software requirements, see *Hardware and System Software Specifications (Bill of Materials) for Cisco Unified ICM/Unified Contact Center Enterprise & Hosted, Release 8.0(1)* for this release (located on the Cisco web page: [http://www.cisco.com/en/US/products/sw/custcosw/ps1001/products_user_guide_list.html](http://www.cisco.com/en/US/products/sw/custcosw/ps1001/products_user_guide_list.html)).
Important Considerations

Before you begin

Cisco recommends that you disable home or cell phone calling features that might affect a customer call experience before you log in. Examples of calling features are, but may not be limited to:

- Call waiting
- Call forwarding
- Voicemail

Before you log in and begin to process calls as a Mobile Agent, be aware of the way Mobile Agent operates. Remember that:

- Mobile Agents cannot perform agent state and call control without a CTI Desktop.
- Unified Mobile Agent supports Outbound Option calls only in nailed connection delivery mode.
- If a Mobile Agent on one PG calls a Mobile Agent on a different PG, and both PGs are connected to the same Unified CM cluster, only blind transfer/conference are supported.
- During a consult transfer or conference call, a source mobile agent does not hear a ring back after dialing the destination agent because the media stream cannot be bridged until that agent answers. The source agent hears Music on Hold (MoH), if it is configured.
- You cannot transfer or conference a call using the buttons on your Mobile Agent phone; you must use the agent desktop to perform these functions.
- If you log in and intend to use nailed connection mode, you must answer the setup call before you complete the login.
- If a Mobile Agent in call by call mode places an outbound call—that is, uses the CTI OS Agent Desktop Dial button or the Cisco Agent Desktop Make Call button—the agent's phone rings before the destination phone rings. This happens because Unified CCE establishes the agent call leg before it establishes the destination call leg.
- By default, a Mobile Agent in nailed connection mode on CTI OS Agent Desktop does not ring when a call arrives.
Note

For more information about how to change the default setting, see Enable Ringtone.

Note

If a Mobile Agent in nailed connection mode has not disabled voicemail and rejects the setup call, the setup call is sent to voicemail. The Mobile Agent continues to be logged in to the CTI Desktop and agent state is set to Ready. However, because the setup call was not accepted, the system logs out the Mobile Agent when the voicemail ends and the agent phone line disconnects.
Unified Mobile Agent for agents

Unified Mobile Agent is available on the following Cisco Agent Desktops:

- Cisco CTI OS Agent Desktop
- Cisco Agent Desktop and Cisco Agent Desktop-Browser Edition
- Cisco Finesse Agent Desktop

- CTI OS Agent Desktop, page 39
- Cisco Agent Desktop, page 44
- Cisco Finesse, page 48

CTI OS Agent Desktop

Unified Mobile Agent is available with the Cisco CTI OS Agent Desktop.

CTI OS Agent Desktop provides an interface that:

- Enables you to perform telephony call control, such as call answer, hold, conference, and transfer, and agent state control, such as ready/not ready and wrap-up
- Presents customer call data in the form of a popup window
- Provides you with agent statistics and chat capability

Note

CTI OS supports chat only between agents on the same peripheral.

Note

For more information about using CTI OS Agent Desktop to handle calls, see the CTI OS Agent Desktop User Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted.
Log In to CTI OS Agent Desktop

Perform the following steps to log in to the CTI OS Agent Desktop.

**Procedure**

**Step 1** From the desktop, click **Login**. The CTI Login dialog box appears.

*Figure 9: CTI Login*

**Step 2** In the **CTI Login** dialog box, enter the following information in the corresponding fields:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to</td>
<td>Use the drop-down menu to select the connection mode you want to use.</td>
</tr>
<tr>
<td>Agent ID or Agent Login Name</td>
<td>Your supervisor assigns your Agent ID.</td>
</tr>
<tr>
<td></td>
<td>Note You are prompted to enter either your Agent ID or Agent Login Name.</td>
</tr>
<tr>
<td></td>
<td>Login options are determined during the installation of the CTI OS Server.</td>
</tr>
<tr>
<td>Password</td>
<td>Your supervisor assigns your this password.</td>
</tr>
<tr>
<td>Instrument</td>
<td>The directory number for the local CTI port; this is your Unified CCE phone</td>
</tr>
<tr>
<td></td>
<td>extension.</td>
</tr>
<tr>
<td>Mobile Agent</td>
<td>You must select this check box to log in as a Mobile Agent.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>The dial number for the phone the agent intends to use.</td>
</tr>
<tr>
<td></td>
<td>Note The format for the phone number must follow the dial plan, for example,</td>
</tr>
<tr>
<td></td>
<td>91201-123-xxxx.</td>
</tr>
</tbody>
</table>
Call Mode

Use the drop-down menu to choose the connection mode you want to use: call by call or nailed connection.

**Note**  Auto-answer is supported only with the nails connection mode.

Select nailed connection.

---

**Step 3** Click OK.

The desktop automatically enters the state that is configured on the switch (either Ready or Not Ready) and the buttons for actions for that state are enabled.

**Note**  For a nailed connection, the desktop must receive and answer a setup call before agent login is complete.

---

**Related Topics**

- Connection modes, on page 5

---

**Verify Login**

Perform the following procedure to verify your login.

**Procedure**

**Step 1** Check to be sure that your desktop is in the Ready or Not Ready state.

**Note**  Switch configuration determines the state the desktop enters at login time.

**Step 2** Check to be sure the status bar of your Unified Mobile Agent Desktop displays the following:

- Agent ID for the logged-in agent
- Agent Extension
- Agent Instrument
- Current Agent Status
- The server that the desktop is connected to

**Step 3** Check to be sure the action buttons that are allowed for your current agent state are enabled.

**Note**  If you log in as a Mobile Agent and want to make a phone call from CTI OS Agent Desktop, you must use the CTI Dialing Pad on the desktop.

---

**Enable Ringtone**

**Note**  This procedure applies only to agents using CTI OS Agent Desktop in nailed connection delivery mode.
By default, a CTI OS Agent Desktop in nailed connection delivery mode does not ring when a call arrives. Instead, an alert message appears on the desktop to indicate the arrival of a call.

Perform the following procedure to enable a ringtone on the CTI OS Agent Desktop:

**Procedure**

---

**Step 1**
Click **Dial**.
The CTI Dialing Pad dialog box appears.

**Step 2**
Click **More**.
The Options dialog box appears.

**Step 3**
Click the **Mute Tones** tab and uncheck the **Ring Back** check box.
This action disables the Mute setting of the ringback tone.

**Step 4**
Click **Close**.

This setting remains in effect until you change it or log out. You need to repeat these steps each time you log in.

**Related Topics**

- Nailed Connections, on page 7

---

**Enable Ready State**

**Note**
Once you are placed in the Ready state, the ring tone is heard through the speakers of the physical machine where the Agent Desktop is installed.

**Note**
Once you are placed in the Ready state, the ring tone is heard through the speakers of the physical machine where the Agent Desktop is installed.

**Procedure**

If you are in the Not Ready state and the **Ready** button is enabled, click the **Ready** button.

---

**Initiate a Call**

**Procedure**

---

**Step 1**
Enter a state from which you can make a call. (You are in the correct state to make a call if the Dial button is enabled.)

**Note**
Depending on the switch, you can also make calls if the Ready or Not Ready buttons are enabled.
Step 2 Use the CTI Dial Pad to enter a phone number.

Transfer a Call

Procedure

Step 1 Click the Transfer button.
The CTI Dialing Pad dialog box appears.
Step 2 Enter the phone number to be dialed in the Dialed Number field or select a destination from the pull-down menu.
The pull-down menu contains the last six numbers dialed from this desktop.
Step 3 Optionally, click the More button to display the Call Data tab, where you can optionally enter data associated with the call.
Step 4 Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you do want to speak with the consulted agent, click the <strong>Transfer Init</strong> button.</td>
<td>When you press the Transfer Init button, the call is put on hold. The agent has an opportunity to speak to the consulted agent before completing the transfer. When the consult call is answered, the button changes to Transfer Complete. To complete the transfer, click <strong>Transfer Complete</strong>.</td>
</tr>
<tr>
<td>If you do not want to speak with the consulted agent, click <strong>Single Step</strong>.</td>
<td>The call automatically transfers.</td>
</tr>
</tbody>
</table>

Conference a call

Procedure

Step 1 Click the Conference button.
The CTI Dialing Pad dialog box is appears.
Step 2 Enter the phone number to be dialed in the Dialed Number field or select a destination from the pull-down menu. The pull-down menu contains the last six numbers dialed from this desktop.
Step 3 Optionally, click the More button to display the CTI Dialing Pad.
Step 4 Click the Conference Init button.
This action places the call on hold, which gives you an opportunity to speak to the consulted agent before completing the conference. When you answer the consult call, the button changes to **Conference Complete**.
Step 5 Click **Conference Complete** to complete the conference.
The two calls now appear on the Call Information Grid as one call.

---

**CRM Desktop Integration Through Unified CCE Through CTI OS**

You can integrate Customer Relationship Management (CRM) applications with Unified CCE through CTI OS to allow an agent to log in through their CRM application, and you can enhance the CRM applications to allow an agent to have a Unified Mobile Agent Checkbooks option and to supply a call mode and phone number. However, you must enhance those integrated CRM interfaces to support using Unified Mobile Agents. It is likely that a Unified Mobile Agent can log in through the CTI OS Agent Desktop and then continue to use the integrated CRM agent interface as usual for call control and any further agent-state control. However, the product manager/owner should verify this capability for each CRM integrated offering.

The Cisco CTI Driver for Siebel is an installable component developed by Cisco that enables integration of the Unified CCE with the Siebel CRM Environment. In this solution, the Siebel Agent Desktop provides the agent state and call control interface. The Siebel Desktop utilizes the Cisco CTI Driver for Siebel, which is built on top of the CTI Desktop Toolkit C++ CIL to communicate with the CTI Object Server. For more information about CRM desktop integrations, see the *Cisco Unified Contact Center Enterprise 8.x Solution Reference Network Design (SRND)* guide.

---

**Cisco Agent Desktop**

Unified Mobile Agent is available with the Cisco Agent Desktop. Cisco Agent Desktop:

- Provides call control capabilities, such as call answer, hold, conference, and transfer, and ACD state control—ready/not ready, wrap up, and so on
- Presents customer information through an enterprise data window and an optional screen pop
- Requires minimum screen real estate and enables agents to customize its functionality to meet their individual needs

*Note* For more information about using Cisco Agent Desktop to handle calls, see *CTI OS Agent Desktop User Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted*.

---

**Log in to Cisco Agent Desktop**

Perform the following procedure to start the Cisco Agent Desktop and log in as a Mobile Agent.

**Procedure**

**Step 1** Choose Start > Programs > Cisco > Desktop > Agent.
The **Mobile Agent Login** dialog box appears.

*Figure 10: Mobile Agent Login*

![Mobile Agent Login Dialog Box](image)

**Step 2** Enter your **Login Name/Agent ID**.
You are prompted to enter either your Agent ID or Login Name. Login options are determined during the installation of the CTI OS Server.

The maximum length for the Login Name field is 32 characters. For Agent ID, extension and password fields, the maximum data length is limited to 12 characters.

**Note** If the login method (Login Name or Agent ID) is changed while you are in the process of logging in, an error message appears to indicate that the log in method has changed. You must restart agent desktop to log in using the new method.

**Step 3** Enter your **Password**.

**Step 4** Enter your **Extension**.
Agent desktop can control only those calls on the extension you enter in this field, regardless of whether the Mobile Agent is configured with multiple extensions.

**Step 5** Select **Mobile Agent Mode**.

**Step 6** Under Mobile Agent Parameters, select a call delivery mode.

**Step 7** Specify a **Mobile Agent Phone Number**. The dial number for the phone you are using.

**Note** The Mobile Agent Phone Number field can contain only numeric characters.

**Step 8** Click **OK**.
The agent desktop starts and is immediately minimized on the taskbar at the bottom of the Mobile Agent's Windows desktop.
For a nailed connection, a setup call must be received and answered before agent login is complete.

Verify login to Cisco Agent Desktop

Procedure

Check to be sure your Cisco Agent Desktop displays the following:

- Your agent name, as configured in Unified ICM
- Your agent extension, as entered in the Login dialog box
- Your agent ID or name, as entered in the Login dialog box
- Your current agent state and the time spent in that state
- Current status of agent desktop features
- Current system time

Note
Remember, you must enter the Ready state before you can begin processing calls.

Enable Ready state

You must be set to the Ready state to answer an ACD call.

Procedure

On the toolbar, click Ready.

Initiate a call

Procedure

Step 1 Click Not Ready.
   Note You must be in the Not Ready state to initiate a call.
Step 2 Click Make Call.
   The Make a Call window appears.
Step 3 Enter a number in the Name: Number field.
Step 4 Click Dial.
Transfer a call

There are two types of transfer calls:

- **Supervised transfers**: In a supervised transfer, the Mobile Agent speaks to the third party to whom the call is being transferred before connecting the active call; this allows the Mobile Agent to confirm that the third party is ready to accept the call.

- **Blind transfers**: In a blind transfer, the Mobile Agent transfers the active call to the third party without speaking. The remote agent hangs up before the third party answers the phone and therefore, cannot confirm if the third party is ready to accept the call.

Use the following instructions to transfer a call.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>With a call active, click <strong>Transfer</strong>. The <strong>Transferring Call</strong> window appears.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Enter the phone number to which the remote agent is transferring the call in the Name: Number field.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Click <strong>Dial</strong>.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>When the phone rings, the <strong>Dial</strong> button changes to the <strong>Transfer</strong> button.</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Do one of the following:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you want to do a supervised transfer</td>
<td>Wait for the third person to answer the phone, announce the transfer, then click <strong>Transfer</strong>.</td>
</tr>
<tr>
<td>If you want to do a blind transfer</td>
<td>Click <strong>Transfer</strong> without waiting for the third person to pick up the phone.</td>
</tr>
</tbody>
</table>

Conference a Call

There are two types of conference calls:

- **Supervised conference**: In a supervised conference, the Mobile Agent speaks to the third party the agent wants to add to the call before completing the conference, to confirm that the third party is ready to accept the call.

- **Blind conference**: In a blind conference, the Mobile Agent adds the third party to the conference without speaking to them.
When using a blind conference to add someone to the call, the remote agent might or might not see the call tagged as a conference call in the dashboard pane.

Use the following instructions to make a conference call.

**Procedure**

**Step 1** With a call active, click **Conference**.
The **Conferencing** window appears.

**Step 2** Enter the phone number of the person the Mobile Agent wants to add to the call in the Name: Number field.

**Step 3** Click **Dial**.
When the phone rings, the **Dial** button changes to the **Add to Conf** button.

**Step 4** Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you want a supervised conference</td>
<td>Wait for the third person to answer the phone, announce the conference, then click <strong>Add to Conf</strong>.</td>
</tr>
<tr>
<td>If you want a blind conference</td>
<td>Click <strong>Add to Conf</strong> without waiting for the third person to pick up the phone.</td>
</tr>
</tbody>
</table>

The **Conferencing** window closes.

**Step 5** To add one or more people to the conference call, repeat Steps 1 to 4 for each person.

**Note** The total number of conference call participants on a call is determined by settings on the Unified CM.
Ask you supervisor for the total number configured for your contact center.

---

**Cisco Finesse**

Unified Mobile Agent is available with Cisco Finesse, Release 9.0(1) or later.

Finesse provides a browser-based desktop for agents and supervisors. Mobile agents can perform the same call control functions as Packaged CCE agents. Mobile supervisors can perform all call control functions except for silent monitoring.
Sign In to Cisco Finesse Agent Desktop

Procedure

Step 1 Enter the following URL in your browser: http://hostname/, where hostname is the hostname or IP address of the Finesse server.

Step 2 In the ID field, enter your agent ID.

Step 3 In the Password field, enter your password.

Step 4 In the Extension field, enter your extension.
   For a mobile agent, the extension represents the virtual extension for the agent, also known as the local CTI port (LCP).

Step 5 Check the Sign in as a Mobile Agent check box.
   The Mode and Dial Number fields appear.

Step 6 From the Mode drop-down list, choose the mode you want to use.
   In Call by Call mode, your phone is dialed for each incoming call and disconnected when the call ends.
   In Nailed Connection mode, your phone is called when you sign in and the line stays connected through multiple customer calls.

Step 7 In the Dial Number field, enter the number for the phone you are using.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The agent ID.</td>
</tr>
<tr>
<td>Password</td>
<td>Your supervisor assigns your this password.</td>
</tr>
<tr>
<td>Extension</td>
<td>The agent's extension.</td>
</tr>
<tr>
<td>Sign in as Unified Mobile Agent</td>
<td>Select to sign in as a Unified Mobile Agent.</td>
</tr>
</tbody>
</table>
Nailed Connection is the only available selection.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Nailed Connection is the only available selection.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dial Number</td>
<td>The number of the phone being used.</td>
</tr>
</tbody>
</table>

**Step 8**  
Click **Sign In**.

**Note**  
In Nailed Connection mode, the desktop must receive and answer a setup call before sign-in is complete.

In Call by Call mode, the dial number provided is not verified. To ensure the number is correct, verify the number in the header on the Agent Desktop after sign-in is complete.

---

**Verify Sign-In to Cisco Finesse**

**Procedure**

Check to be sure the Finesse Agent Desktop displays the following in the header:

- *Mobile Agent* before your agent name
- The mode used (Call by Call or Nailed Connection)
- The dial number you provided

**Enable Ready State**

You must be in Ready state to process incoming calls.

**Procedure**

Choose **Ready** from the drop-down list below the agent name.

**Note**  
If you are in Call by Call mode, you must answer each incoming call on your physical phone. After you answer a call, you can perform all other call control functions (such as Conference, Transfer, Hold, Retrieve) using the desktop.

If you are in Nailed Connection mode, after you answer the initial setup call, you must perform all other call control functions using the desktop.
Make a Call

Procedure

Step 1  From the drop-down list below the agent name, choose Not Ready.
Note  You must be in Not Ready state to make a call.

Step 2  Click Make a New Call.

Step 3  Enter the number you want to call on the keypad, and then click Call.
If you are in Call by Call mode, the CTI server sends a setup call to your phone. A message appears on the keypad that states the following:
A call will be initiated to your phone which must be answered before an outbound call to your destination can be made.

After the setup call is answered, the system establishes the outbound call to the destination specified.
CHAPTER 5

Unified Mobile Agent for supervisors

Unified Mobile Agent is available on the following Cisco supervisor desktops:

- Cisco CTI OS Supervisor Desktop
- CAD Supervisor Desktop
- Cisco Finesse

For more information about Cisco Finesse sign-in and call control, see Cisco Finesse.

CTI OS Supervisor Desktop

Unified Mobile Agent is available with CTI OS Supervisor Desktop. The CTI OS Supervisor Desktop has all of the functionality of the agent desktop, with additional functions for monitoring and managing Agent Team members.

CTI OS Supervisor Desktop is supported for use only on Unified CCE/Unified CCH. It is not supported for use on TDM peripherals.

The instructions that follow describe CTI OS Supervisor Desktop tasks that are specific to configuring and interacting with Mobile Agents. For more information about using this desktop, see CTI OS Supervisor Desktop User Guide for Cisco Unified Contact Center Enterprise & Hosted.
Log in to CTI OS Supervisor Desktop

**Procedure**

**Step 1** Choose **Start > Programs > Cisco Systems CTI Toolkit > IPCC Supervisor Desktop**. The Supervisor Softphone and Team Real-Time Status windows appear.

**Step 2** On the softphone, click **Login**. The Login dialog box appears.

**Step 3** Enter the following information in the dialog box:

<table>
<thead>
<tr>
<th>Connect to</th>
<th>Use the drop-down menu to select the connection mode that you want to use.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent ID or Agent Login Name</td>
<td>The agent ID as assigned by the agent's manager.</td>
</tr>
<tr>
<td>Note</td>
<td>Depending on the option chosen for logging in during the installation of the CTI OS Server, the Login dialog on the agent desktop prompts for either the Agent ID or the Agent Login Name.</td>
</tr>
<tr>
<td>Password</td>
<td>The password as assigned by the agent's manager.</td>
</tr>
<tr>
<td>Instrument</td>
<td>The directory number for the local CTI port (the agent's virtual extension).</td>
</tr>
<tr>
<td>Mobile Agent</td>
<td>Select this check box to log in as a Mobile Agent.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>The dial number for the phone the Mobile Agent is using. This should include all dial-plan information Unified CCE/Unified CCH needs to reach the agent phone.</td>
</tr>
<tr>
<td>Call Mode</td>
<td>Choose nailed connection or call by call. A new call is placed to the agent for each incoming call.</td>
</tr>
<tr>
<td>Note</td>
<td>- If you log in using nailed connection mode, you must answer a setup call before login is complete.</td>
</tr>
<tr>
<td></td>
<td>- Auto answer is supported with the Unified Mobile Agent nailed connection mode. It is not supported with the Unified Mobile Agent call by call connection mode.</td>
</tr>
</tbody>
</table>

**Step 4** Click **OK**. The supervisor automatically enters the Not Ready state and the Ready, Dial, and Logout agent state control buttons are enabled.

**Related Topics**

- Connection modes, on page 5
Verify login to Supervisor Desktop

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Check that your desktop is in the Not Ready state.</td>
</tr>
</tbody>
</table>
| Step 2 | Check that the status bar of your Unified Mobile Agent Supervisor Desktop displays the following:  
  - Agent ID for the logged in supervisor  
  - Supervisor Extension  
  - Supervisor Instrument  
  - Current Supervisor Status  
  - The server that the Supervisor is connected to |
| Step 3 | Check that the Ready, Dial, and Logout agent state control buttons are enabled. |

Mobile Agent configuration

CTI Desktop agent configuration is handled through Unified ICM Configuration Manager.

**Related Topics**

- Configure Agent Desk Settings with Configuration Manager, on page 26

Monitor Mobile Agent call

A supervisor can silent monitor an agent on their team. The Silent Monitoring feature voice packets sent to and received by the agent's IP device are captured from the network and sent to the Supervisor Desktop. At the Supervisor Desktop, these voice packets are decoded and played on the supervisor’s system sound card.

**Note**

For more information about Silent Monitoring, see *CTI OS Supervisor Desktop User Guide for Cisco Unified Contact Center Enterprise & Hosted*.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Select a logged-in agent from the Team State Information grid.</td>
</tr>
</tbody>
</table>
| Step 2 | In the Team State window, click **Start Silent Monitor**.  
When the targeted agent desktop accepts the session, the voice conversation between the monitored agent and the caller is forwarded to the Supervisor Desktop and played back on the soundcard of the system. |
| Step 3 | Click **Stop Monitoring Agent** to end the monitoring session. |
**CAD Supervisor Desktop**

Unified Mobile Agent is available with CAD Supervisor Desktop. The CTI OS Supervisor Desktop has all of the functionality of the agent desktop, with additional functions for monitoring and managing Agent Team members.

The instructions that describe CAD Supervisor Desktop tasks are specific to configuring and interacting with Mobile Agents. For more information about using this desktop, see *CAD Supervisor Desktop User Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted*.

**Log in to Supervisor Desktop**

**Procedure**

**Step 1** Log in to Cisco Agent Desktop.

**Note** You must be logged in to use all of Supervisor Desktop's functionality.

**Step 2** Choose **Start > Programs > Cisco > Desktop > Supervisor**.

The Supervisor Login dialog box appears.

**Step 3** Enter your Supervisor Desktop login ID and password, and then click **OK** or press **Enter**.

Supervisor Desktop starts. The application shows no data and the status bar displays "No Service" until you select a team from the Team drop-down list.

**Note**

- The administrator can configure the Supervisor Desktop so that you log in using your login name, not your login ID. The field name (Login ID or Login Name) reflects which login method to use.
- The first time you log in to Supervisor Desktop, the password is empty by default—all you need to enter is your Login ID. Use the Change Password function to create your password.
- It might take some time for Supervisor Desktop to start because default report data must be generated.

**View Mobile Agent**

**Procedure**

**Step 1** In Supervisor Desktop, choose **View > Preferences**, and then select the Agents node.

**Step 2** In the Format node text grid, check the elements you want to use to identify an agent.

The elements are:

- Name
- Extension
- Application used by the agent (CAD, CAD-BE, or IPPA)
• Type of agent (mobile)

A sample of what the name looks like appears on the Sample line.

Step 3  Click OK.

Example:
For example, if you enter John Doe x1000 CAD 6125551234 (Mobile):

• *John Doe* is the agent name.
• *x1000* is the CTI port the agent is connected to when logging in.
• *CAD* is the application the agent uses.
• *6125551234 (Mobile)* is the number of the phone device the Mobile Agent is using to handle calls.
PART III

Configuration and troubleshooting for Remote Agent

- Overview, page 59
- Introduction to Unified CCE Remote Agent Option, page 61
- System Configuration for Remote Agent with IP Phone, page 69
- System Configuration for Remote Agent with analog phone, page 71
- Remote Agent user information, page 75
- Troubleshooting Unified CCE Remote Agent Option, page 83
- Sample Cisco IOS configuration for analog FXO to PRI gateway, page 87

Overview

Remote Agent, the predecessor of Mobile Agent, offers two deployment options:
- Remote Agent with IP Phone (over a Cisco Business Ready Teleworker setup)
- Remote Agent with analog phone

Mobile Agent provides flexibility and ease of use benefits compared to the Remote Agent with analog phone. Remote Agent continues to be supported for customers who already have it installed.

However, if you are upgrading to 8.0(1) and are planning to configure a Mobile Agent to use an analog phone or an IP Phone without Cisco Business Ready Teleworker setup, use the Mobile Agent Option.
Remote Agent continues to be the product of choice for remote IP Phone with the Cisco Business Ready Teleworker setup.
CHAPTER 6

Introduction to Unified CCE Remote Agent Option

Unified CCE Remote Agent Option provides the capability to use remote agents when staffing contact centers.

Note

A remote agent is classified as limited to a single agent working at a remote site, such as the agent's home or in an office outside the contact center's headquarters. They are not classified as agents working at one of the contact center's sites. Multiple agents sitting in remote sites are considered branch agents.

Support is provided for remote agents using one of the following options:

• Remote Agent with IP Phone (over a Cisco Business Ready Teleworker setup)

Note


• Remote Agent with analog phone

By means of this support, Cisco Unified CCE remote agents with IP Phone can benefit from standard Cisco 8xx series Router support, persistent VPN, Cisco IOS based security, and QoS for voice.

Agents are connected to the corporate network using a residential broadband (cable or DSL) network connection that can support voice, data, and video traffic. The connection is secure, and provides "always-on" access to call-center applications using a VPN. Built-in, end-to-end security helps ensure that confidential customer information, such as medical records and financial information, is protected, and the corporate network is secure from "back door" attacks.

• Unified CCE Remote Agent Option primary components, page 62
• How Unified CCE Remote Agent Option works with an analog phone, page 64
• Remote agent with IP phone call flow, page 65
• Remote agent with analog phone call flow, page 66
Unified CCE Remote Agent Option primary components

The primary components of the Unified CCE Remote Agent Option are:

- **Cisco IP Contact Center solution**: Cisco IP Contact Center combines Cisco IP telephony and ready-to-use computer telephony integration (CTI) capabilities in a call-center product suite. The software includes intelligent call routing, multichannel automatic call distribution (ACD) capability, IVR, call queuing, and consolidated reporting features.

  Cisco IP Contact Center components include the following:

  - Unified CM: Provides traditional private branch exchange (PBX) telephony features and functions to packet-telephony devices. Installed on a server-class PC, Unified CM software provides basic call processing, signaling, and connection services to Cisco IP Phones, VoIP gateways, and software applications.
  
  - Cisco Computer Telephony Integration Object Server (CTI OS) Desktop and Cisco Agent Desktop: Allow an agent to control the remote agent state (for example, Login, Available/Unavailable, and Work or Wrap Up) and perform call control (answer, release, hold, and transfer).
  
  - Cisco Unified Customer Voice Portal (Unified CVP) (formerly Internet Service Node) or Cisco Unified IP-IVR: Provides announcements, prompting, gathering of caller-entered digits, and a queue point to park calls when all remote agents are busy.
  
  - VoIP gateways.
  
  - Centralized monitoring and recording: Provides call-center managers with real-time and historic data for all remote agents.

- **Cisco Business Ready Teleworker architecture** (for IP Phone only): The Cisco Business Ready Teleworker architecture, combined with Cisco IP Contact Center, gives remote agents the same accessibility to call-center applications as staff based at central sites. Cisco Business Ready Teleworker provides the most comprehensive security and network management available in a teleworking environment over a standard cable or broadband connection. This includes QoS to help ensure prioritization of mission-critical or delay-sensitive traffic. Cisco Business Ready Teleworker can be quickly and cost-effectively deployed to deliver high-quality, consistent application access for remote agents through an always-on, secure, and centrally managed connection to the enterprise network.

  **Note** A remote agent using an analog phone does not require a Cisco 8xx Series Router and does not use the Cisco Business Ready Teleworker setup.

  Cisco Business Ready Teleworker components include the following:

  - VPN: Provides secure, consistent access to information, call-center applications, and customer data. The VPN tunnel is transparent to applications and the end user, and promotes stable and consistent application behavior over the WAN, protecting and extending existing infrastructure investments.

  **Note** Agents receive persistent VPN communication from the Cisco 800 Series Router.
• Advanced application access: With IP telephony a separate PBX, voice switch, or ACD call-control platform at the remote-agent location is not needed. Network-based ACD extends call-center services to thousands of remote-agent locations simultaneously.

• QoS: Helps ensure high-quality voice communication between the caller and remote agent. Voice, data, and video can be delivered over the same line by prioritizing applications based on bandwidth requirements or business priorities.

**Note**
QoS delivers marked tagged packets, but the service is not guaranteed because it is over a service provider network.

• Network security and authentication: Security is integrated completely with all other functions. End-to-end security options for remote agents include trust and identity options (802.1x authentication), integrated firewall, and intrusion detection system (IDS).

• Centralized management and support: Helps ensure control over the performance of remote agents as though they were based on the main call center. Administrators can push policies and configurations transparently to remote-agent locations, perform quality surveys, and do real-time remote monitoring.

For more information, see:


### How Unified CCE Remote Agent Option works with an IP phone

**Note**
Unified CCE Remote Agent Option with IP Phone is supported on the Unified CCE, the Cisco Unified Contact Center Hosted (Unified CCH), and the Cisco Unified Contact Center Express solutions.

At the remote agent site, a Cisco IP Phone, with an ACD extension number, connects to a Cisco 8xx Series secure, persistent Broadband Router that provides a secure VPN connection back to the call center over a broadband facility. The router, based on Cisco IOS Software, provides all the features necessary for an always-on, business-ready connection in a single cost-effective platform. A Unified CM on the corporate network provides the call management on the IP Phone.
This is one option available when using Unified CCE Remote Agent Option. This product is also available using the Remote Agent with analog phone.

**Figure 11: IPCC Remote Agent Option with IP Phone**

When a call comes in to the call center, the Unified CM alerts the Cisco IP Contact Center, which then finds the best available remote agent based on customer-defined business rules. If no remote agents are available, the call is held in an IVR queue, and the caller hears a recorded message or music until an agent becomes available.

**How Unified CCE Remote Agent Option works with an analog phone**

**Note**

Unified CCE Remote Agent Option with analog phone is supported only on the Unified CCE Enterprise Edition and the Unified CCE Hosted Edition solutions.
At the remote agent site, an analog phone connects to the PSTN and using an active broadband connection, the agent uses VPN to access the corporate site (using SoftVPN client) from their PC.

*Figure 12: IPCC Remote Agent Option with analog phone*

When a call comes in to the contact center, the Unified CM alerts the Cisco IP Contact Center, which then finds the best available remote agent based on customer-defined business rules. If the remote agent is on an analog phone, Unified CM sends the call to the Voice Gateway (VG248), which in turn sends it to the PSTN through the VoIP gateway’s PRI lines. If no remote agents are available, the call is held in an IVR queue, and the caller hears a recorded message or music until an agent becomes available.

**Remote agent with IP phone call flow**

The following figure displays a typical call flow.

*Figure 13: Remote Agent with IP Phone Call Flow*

The following describes the call flow for a remote agent with IP phone:

1. The remote agent becomes available by logging in to the corporate domain using VPN over the ADSL/Cable connection, and by launching the agent desktop interface to log in to the CTI server. The remote agent then goes into a ready mode.
2. Customer calls in from PSTN.
3 Call flows in on PRI VoIP gateway.
4 Call is processed by Unified CM and routed to Unified IP IVR.
5 Call is sent to the remote agent.
6 The remote agent's IP Phone rings and the agent desktop receives a screen pop with the incoming call.
7 The supervisor, whether remote or in a contact center, can fully control an agent, including barge, intercept, chat, and state controls.

Remote agent with analog phone call flow

The following figure displays a typical call flow.

Figure 14: Remote Agent with Analog Phone Call Flow

The following describes the call flow for a remote agent with an analog phone:

1 The remote agent becomes available by logging in to the corporate domain using VPN over the ADSL/Cable connection, and by launching the agent desktop interface to log in to the CTI server. The remote agent then goes into a ready mode.
2 Customer calls in from PSTN.
3 Call flows in on PRI VoIP gateway.
4 Call is processed by Unified CM and routed to Unified IP IVR.
5 A VG248 port is designated as the remote agent phone. An incoming call to Unified CCE sends a ring command to the VG248 port.
6 The VG248 FXS port is connected to the FXO port on the voice gateway.

7 The voice gateway using Private Line Automatic Ring down (PLAR) forwards the ring command over PSTN to the remote agent's analog phone.

8 The analog phone receives the ring command from its local PSTN provider. (This happens because the PLAR was sent from the Unified CCE voice gateway.)

9 The remote agent's analog phone rings and the agent desktop receives a screen pop with the incoming call.
Remote agent with analog phone call flow
System Configuration for Remote Agent with IP Phone

- Configuration guidelines, page 69
- Remote agent with IP phone considerations, page 70

Configuration guidelines

The following tables provide configuration checklists and guidelines to follow when you use the Remote Agent with IP Phone.

Note


Configure Remote Agent with IP phone

Note

Unified CCE Remote Agent Option with IP Phone is supported on the Unified CCE, the Unified CCH, and Cisco Unified Contact Center Express solutions.

Procedure

Step 1 Provision the remote agent PC and IP Phone on the Unified CCE central site to ensure operability before distributing it to a remote agent site.

Step 2 At a remote agent site, connect the agent desktop to the RJ45 port on the back of the IP Phone.

Note The IP Phone and agent desktop PC get their network settings from DHCP.
Step 3  Create a DNS entry for the remote agent desktop; otherwise, an agent cannot connect to a CTI server. You can dynamically update or enter DNS entries.

Step 4  Configure the agent desktop PC at the remote site with an IP address, network mask, DNS, and default gateway configured for DHCP.

Step 5  Make sure the 7960 IP Phone has a power supply. (The Cisco 8xx Series Router cannot supply power to the IP Phone.)

Step 6  Critical remote agents must have a backup power supply. The backup power supply must be able to power a PC, an 831 Router, a broadband modem, and an IP Phone.

Remote agent with IP phone network requirements checklist

<table>
<thead>
<tr>
<th>Network Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure the ADSL and Cable bandwidth values are set to at least 256 kb uplink and 1 Mbps downlink.</td>
</tr>
<tr>
<td>Do not exceed 60 ms to 90 ms of jitter delay each way on the maximum ADSL network delay. If the ADSL delay is greater than the maximum, the IPCC application encounters longer response times.</td>
</tr>
<tr>
<td>Make sure the Unified CCE bandwidth value does not exceed 128 k uplink; otherwise, the remote agent solution might not work properly.</td>
</tr>
<tr>
<td>The default codec for 256 kb uplink is the G.729. To achieve higher voice quality, use the G.711.</td>
</tr>
<tr>
<td>Only unicast Music on Hold (MoH) streams are supported.</td>
</tr>
<tr>
<td>Set up a transcoder to enable outside callers to receive MoH, if the MoH server is not set up to stream G.729 codec.</td>
</tr>
<tr>
<td>As a backup to the remote agent desktop, you can configure the remote agent to use the IP Phone as a login device when possible.</td>
</tr>
</tbody>
</table>

Remote agent with IP phone considerations

IP Phones supported with Unified CCE Remote Agent Option are those currently compatible with IPCC as listed in the Hardware & System Software Specification (Bill of Materials) for Cisco Unified ICM/Contact Center Enterprise & Hosted, Release 9.0(1).
System Configuration for Remote Agent with analog phone

- Configuration guidelines, page 71
- Remote agent with analog phone considerations, page 73

Configuration guidelines

The following tables provide configuration checklists and guidelines to follow when using the Remote Agent with analog phone.

Note

Configure remote agent with analog phone at central office site

Note
Unified CCE Remote Agent Option with analog phone is supported only on the Unified CCE Enterprise Edition and the Unified CCE Hosted Edition solutions.

Provision the remote agent PC and analog phone on the Unified CCE central site to ensure operability before you distribute it to a remote agent site.

Configuration Summary: Add the VG248 voice gateway to the Unified CM configuration at the central office site. Each of the ports on the VG248 are what the agents use as their login devices when they are remote. These are the extensions they use when they log in. The configuration on the VG248 is a connection through PLAR routing direct to the agents home (or remote) phone.
Procedure

**Step 1** On the Unified CM, assign a Directory Number (DN) to a port on the VG248; for example: 6777.

**Step 2** On the DC (Domain Controller)/DNS Server, create a DNS entry for the remote agent's desktop; otherwise the agent cannot connect to a CTI server. You can dynamically enter or update DNS entries as static updates. If DNS entries are not desired, ensure that the client connects to the CTI server through IP.

**Step 3** Create labels for the new extension connected to Unified CM and the Unified IP IVR peripheral.

**Step 4** Add the device target to the Unified CCE configuration. For more information, see the *Unified CCE Administration & Configuration Guide*.

**Step 5** Add the device to pguser. For more information, see the *Cisco Unified CM Administration Guide*. Go to the Users—Application and select the user associated with the PG. From the list of unregistered devices, add the appropriate device to the list of associated devices.

**Step 6** Directly connect the VG248 FXS port to a FXO port on the gateway router. Each FXS port you are using on the VG248 is connected to an FXO port on the voice gateway router.

**Step 7** Configure the gateway FXO port as a connection plar to your (the agent's) home (or remote) phone number; for example: 6035551212.

*Note* The phone number must match the dial plan setup in Unified CM.

The connection plar command goes on the FXO port of the gateway router(s).

Related Topics

*Sample Cisco IOS configuration for analog FXO to PRI gateway, on page 87*

**Agent's home configuration and setup**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Configure the agent desktop PC at the remote site with an IP address, a network mask, DNS, and default gateway configured for DHCP.</td>
</tr>
<tr>
<td>2.</td>
<td>Set up the VPN client to connect to the contact center headquarters.</td>
</tr>
</tbody>
</table>

**Example remote connection process**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Ensure that the VPN connection is up.</td>
</tr>
<tr>
<td>2.</td>
<td>Log in to the CTIOS server.</td>
</tr>
</tbody>
</table>
Step | Description
--- | ---
3. | Agent logs in to extension 6777 and goes Available on extension 6777. Unified IPCC Enterprise knows to send the call to 6777. The phone number 6777 is the agent's remote number that is configured at the gateway. You must configure the phone number before the agent can log in. Every port on the VG248 that will be used for agents should have an associated remote phone number to call using the connection plar command.
4. | The agent gets notification that a call is coming and the home (or remote) phone rings.

Remote agent with analog phone network requirements checklist

<table>
<thead>
<tr>
<th>Network Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not exceed 150 ms Round Trip Time (RTT) of ADSL/Cable network delay.</td>
</tr>
<tr>
<td>Do not exceed not exceed 60 ms of jitter delay.</td>
</tr>
<tr>
<td>The minimum broadband bandwidth for the agent desktop is 256 kb uplink and 1 Mbps downlink.</td>
</tr>
<tr>
<td>Configure the voice gateway/access server with at least one active PRI, T1, E1, or DS3 connection to the PSTN.</td>
</tr>
<tr>
<td>The remote agent's phone number is the number assigned via PLAR routing in the VoIP gateway. <strong>Note</strong> The remote agent PSTN phone number might vary in an actual deployment.</td>
</tr>
<tr>
<td>The phones at the remote sites will be analog phones only connected to the PSTN.</td>
</tr>
<tr>
<td>The current configuration only supports unicast Music on Hold (MoH) streams. A Unified CM is the MoH server.</td>
</tr>
<tr>
<td>The maximum PSTN delay supported is 250 ms.</td>
</tr>
<tr>
<td>Configure the VG248 to use G.711.</td>
</tr>
</tbody>
</table>

Remote agent with analog phone considerations

An analog phone is classified as any PSTN phone; for example, a regular touchtone phone or a mobile/cell phone both qualify as analog phones.
Remote agent with analog phone considerations
Remote Agent user information

Unified CCE Remote Agent Option is available on the following Cisco desktops:

- **Cisco CTI Toolkit Agent Desktop**: Provides an interface that enables agents to perform telephony call control and agent state control. The CTI Toolkit Agent Desktop provides an interface to allow call data to be presented to an agent in the form of a screen pop. The CTI Toolkit Agent Desktop also provides agents with statistics and chat capability.

  **Note**: CTI OS supports chat only between agents on the same peripheral.

- **Cisco CTI Toolkit Unified CCE Supervisor Desktop**: The Supervisor Desktop has all of the functionality of the agent desktop, with additional functions for monitoring and managing Agent Team members.

  **Note**: The CTI Toolkit Unified CCE Supervisor Desktop is supported for use only on Unified CCE Enterprise. It is not supported for use on TDM peripherals.

- **Cisco Agent Desktop**: Provides call control capabilities—such as call answer, hold, conference, and transfer, and ACD state control—ready/not ready, wrap up, and so forth. Customer information is presented to an agent through an enterprise data window and an optional screen pop. Cisco Agent Desktop requires minimum screen real estate and enables agents to customize its functionality to meet their individual needs.

  **Note**: Cisco Agent Desktop is not available with IP Phone Agent using an analog phone.
CTI Toolkit and CAD desktops

CTI Toolkit Agent Desktop FAQ

Q. How does an agent log in to the desktop?

A. To log in to CTI Toolkit Agent Desktop, click the Login button. The Login button connects agents to the CTI Server and logs the agent into a selected ACD switch. When an agent clicks the Login button, the CTI Login dialog box appears.

Enter the following information in the dialog box:

- **Connect to.** Use the drop-down menu to select the connection profile that you want to use.
- **Agent ID.** The agent ID as assigned by the agent's manager.

**Note** Depending on the option chosen for logging in during the installation of the CTI OS Server, the Login dialog box on the agent desktop prompts for either the Agent ID or the Login Name.

- **Password.** The password as assigned by the agent's manager.
- **Instrument.** The device ID assigned to the teleset where the agent will receive calls.

After entering this information, click the OK button.

After a successful login, the following occurs:
The agent automatically enters the state configured on the switch, either Ready or Not Ready state.

The status bar on the bottom of the CTI Toolkit Agent Desktop Screen displays the following information:

- Agent ID for the logged-in agent
- Agent Extension
- Agent Instrument
- Current Agent Status
- The server that the agent is connected to

Buttons for actions that are allowed from your current agent state are enabled.

**Note**

If the **Login** button is not enabled when the CTI Toolkit Agent Desktop displays, the remote agent did not successfully log in.

**Q.** How can an agent verify a successful login?

**A.** After a successful login, the following occurs:

- The remote agent automatically enters the state configured on the switch, either Ready or Not Ready state.

- The status bar on the bottom of the CTI Toolkit Agent Desktop window displays the following information:
  - Agent ID for the logged in agent
  - Agent Extension
  - Agent Instrument
  - Current Agent Status
  - The server that the agent is connected to

- Buttons for actions that are allowed from your current agent state are enabled.

**Q.** How does an agent enter the Ready state to start accepting calls?

**A.** An agent enters either Ready or Not Ready state on completion of a successful login, depending on the configuration of the agent's switch. If the agent is in the Not Ready state and the **Ready** button is enabled, enter the Ready state by clicking the **Ready** button.

**Q.** How does an agent perform a transfer?

**A.** To transfer a call, perform the following steps:

1. Click the **Transfer** button. The CTI Dialing Pad dialog box appears.
2 Enter the phone number to be dialed in the Dialed Number field or select a destination from the pull-down menu. The pull-down menu contains the last six numbers dialed from this desktop.

3 Optionally, click the More button to display the Call Data tab, where you can enter data associated with the call.

The remaining steps depend on whether the agent wants to speak with the consulted agent upon call transfer.

- If the agent does not want to speak with the consulted agent, click the Single Step button. The call is automatically transferred.

- If the agent wants to speak with the consulted agent, click the Transfer Init button. After the Transfer Init button is pressed, the call is placed on hold. The agent has an opportunity to speak to the consulted agent before completing the transfer. When the consult call is answered, the button changes to Transfer Complete. To complete the transfer, click the Transfer Complete button.

Q. How does an agent initiate a conference call?
A. To initiate a conference call, perform the following steps:

1 Click the Conference button. The CTI Dialing Pad dialog box appears.

2 Enter the phone number to be dialed in the Dialed Number field or select a destination from the pull-down menu. The pull-down menu contains the last six numbers dialed from this desktop.

3 Optionally, click the More button to display the CTI Dialing Pad.

4 Click the Conference Init button. The call is now put on hold. The agent has an opportunity to speak to the consulted agent before completing the conference. When the consult call is answered, the button changes to Conference Complete. To complete the conference, click the Conference Complete button.

When the conference operation is completed, the two calls then appear on the Call Information Grid as one call.

Q. When is an agent available to make calls?
A. An agent can make calls if the Dial button is enabled. Depending on the agent's switch, the agent can also make calls if the Ready or Not Ready buttons are enabled.

**CAD desktop FAQ**

Q. How does an agent log in to the desktop?
A. To start agent desktop:

1 Choose Start > Programs > Cisco > Desktop > Agent. The Agent Login dialog box appears.

**Note** For Unified CCE only, agent desktop prompts for either the remote agent's Login ID or the Login Name in the Login dialog box. Which prompt appears depends on how the administrator has configured the system.
If the login method (Login Name or Login ID) is changed while the remote agent is in the process of logging in, an error message appears stating that the login method has changed. The remote agent must restart agent desktop to log in using the new method. (The information in this note is not applicable to Cisco Unified Contact Center Express [Unified CCX].)

Note

2. Enter the remote agent login ID or login name, password, and extension in the appropriate fields, and then click OK or press Enter.

- If the remote agent attempts to log in and the login ID/login name (with or without the same extension used in association with it) is already in use by another agent, the remote agent is asked to forcibly log in. If the remote agent opts to do so, that agent is logged in and the other agent using that ID is logged out.

- If the remote agent attempts to log in and the extension is already in use by another agent, that agent cannot log in unless a different extension is entered.

Agent desktop starts and is immediately minimized on the taskbar at the bottom of the remote agent's Windows desktop.

Login notes:

- The maximum length for the Login Name field is 32 characters. For Agent ID, extension and password fields, the maximum data length is limited to 12 characters.

- Agent desktop can control only those calls on the extension entered in the Login dialog box, even if the remote agent is configured with multiple extensions.

Q. How does an agent get into the Ready state to start accepting calls?
A. Clicking the Ready button changes the state to Ready, indicating that the remote agent is available to receive ACD calls.

Q. How does an agent transfer a call?
A. There are two types of transfer calls:

- Supervised transfers. In a supervised transfer, the remote agent speaks to the third party to whom the call is being transferred before connecting the active call, to confirm that the third party is ready to accept the call.

- Blind transfers. In a blind transfer, the remote agent transfers the active call to the third party without speaking. The remote agent hangs up before the third party answers the phone and, therefore, cannot confirm if the third party is ready to accept the call.

To transfer a call:

1. With a call active, click Transfer.
   The Transferring Call window appears.

2. Enter the phone number to which the remote agent is transferring the call in the Name: Number field.

3. Click Dial.
   When the phone rings, the Dial button changes to the Transfer button.
4 Take one of the following actions:
   • For a supervised transfer, wait for the third person to answer the phone, announce the transfer, and then click Transfer.
   • For a blind transfer, click Transfer without waiting for the third person to pick up the phone.

Q. How does an agent initiate a conference call?
A. There are two types of conference calls:
   • Supervised conference. In a supervised conference, the remote agent speaks to the third party they want to add to the call before completing the conference, to confirm that the third party is ready to accept the call.
   • Blind conference. In a blind conference, the remote agent adds the third party to the conference without speaking to them.

Note When using a blind conference to add someone to the call, the remote agent might or might not see the call tagged as a conference call in the dashboard pane.

To make a conference call:
1 With a call active, click Conference.
The Conferencing window appears.
2 Enter the phone number of the person the remote agent wants to add to the call in the Name: Number field.
3 Click Dial.
   When the phone rings, the Dial button changes to the Add to Conf. button.
4 Take one of the following actions:
   • For a supervised conference, wait for the third person to answer the phone, announce the conference, then click Add to Conf.
   • For a blind conference, click Add to Conf. without waiting for the third person to pick up the phone.

   The Conferencing window closes.
5 To add one or more people to the conference call, repeat Steps 1 to 4 for each person.

Note The total number of conference call participants on a call is determined by settings on the Unified CM. Ask your supervisor for the total number configured for your contact center.

Q. When is an agent available to make calls?
A. When the remote agent is in the Not Ready state and the system is functioning to enable call control, the agent is available to make and receive calls.

### Installation and configuration checklists

**Remote Agent with IP phone components checklist**

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Does the IP Phone boot?</td>
<td>Make sure the separate power supply is used for the phone. The 831 router does not supply power to the IP Phone.</td>
</tr>
<tr>
<td>Does the IP Phone register with Unified CM?</td>
<td>The phone must be configured for DHCP; also, domain information must be entered into the phone configuration.</td>
</tr>
<tr>
<td>Is the IPsec tunnel running?</td>
<td>Reboot the 831.</td>
</tr>
<tr>
<td>Do you have internet access?</td>
<td>Make sure you have network access to the internet.</td>
</tr>
<tr>
<td>Can the agent desktop log in to CTI OS Server?</td>
<td>Make sure the PC is registered in DNS.</td>
</tr>
<tr>
<td></td>
<td>Make sure the agent login ID/password is valid.</td>
</tr>
<tr>
<td>When you pick up the IP Phone, does the desktop reflect that the line is off hook?</td>
<td>Cycle the PG for the remote agent.</td>
</tr>
<tr>
<td>Are callers routed to the remote agent?</td>
<td>Make sure callers are routing to the remote agent and the PG is online.</td>
</tr>
<tr>
<td>When the remote agent receives a call, does the desktop client's main window display the incoming call?</td>
<td>Check to see if the desktop client's main window displays the incoming call.</td>
</tr>
<tr>
<td>Is the desktop window displaying the incoming call correctly?</td>
<td>Check to see if the desktop window displays the incoming call correctly.</td>
</tr>
<tr>
<td>What is the readiness state of the agent when taking a call using an IP Phone?</td>
<td>As soon as the agent takes a call (either via the IP Phone or the agent desktop), the agent state changes to either the Talking state or the Not Ready state and the agent is unavailable for calls. (The agent cannot receive any calls while already on a call.)</td>
</tr>
</tbody>
</table>
Remote Agent with analog phone components checklist

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can the agent desktop log in to CTI OS Server?</td>
<td>Make sure the PC is registered in DNS.</td>
</tr>
<tr>
<td></td>
<td>Make sure the agent login ID/password is valid.</td>
</tr>
<tr>
<td>Is there a dial tone?</td>
<td>Pick up the analog phone and listen for a dial tone to ensure the phone is connected.</td>
</tr>
<tr>
<td>Do you have Internet access?</td>
<td>Make sure you have network access to the Internet.</td>
</tr>
<tr>
<td>Are callers routed to the remote agent?</td>
<td>Make sure callers are routing to the remote agent and the PG is online.</td>
</tr>
<tr>
<td>What's the agent's readiness state when taking a call using an analog phone?</td>
<td>Remote agents using an analog phone must manually place themselves in the Not Ready state after taking a call.</td>
</tr>
</tbody>
</table>

Hardware installation and configuration

Troubleshooting Unified CCE Remote Agent Option

• Caveats and limitations, page 83

Caveats and limitations

Remote Agent has limitations regarding the following:

• Agents
• Supervisors
• Network
• Security
• Reporting

Agent limitations

• Only one Unified CCE Remote Agent Option per household is supported.
• Media Termination for CTI OS and Cisco Agent Desktop is not supported.
• CTI OS Agent Login might take up to 30 seconds. CAD Agent Login might take up to two minutes. Other operations such as Ready/Not ready are not impacted.
• There might be times when the ADSL/Cable link goes down. When the link is back up, the remote agent might have to reset their ADSL/Cable modem, 8xx Series Router, and IP Phone. The remote agent must become familiar with restarting the 8xx Series Router. Total time for the router to cycle is about two minutes, after which the remote agent has to log in again for CTI application.
• Cisco Agent Desktop-based IP Phone only agent and Cisco IP Phone control for CTI OS is not supported for remote agents.
• Remote agents might experience a delay in screen pop.
• The analog phone itself cannot initiate transfers, conferences, and holds. These functions can only be executed via the CTI OS/Cisco Agent Desktop agent interface, and only to another agent.

• Remote agents can use the agent desktop interface to initiate calls, but only to other agents.

• A Mobile Agent nailed up call may be terminated by the following two Unified CM timers, and this termination can log out a nailed up Mobile Agent:
  * The Maximum Call Duration timer (the default value is 720 minutes)
  * The Maximum Call Hold timer (the default value is 360 minutes)

To keep the Mobile Agent logged in, the values for both these timers need to be set to 0, which makes the timer never expire.

You can configure these timers from the Unified CM Administration web page from the serviced parameters under the Unified CM service.

**Supervisor limitations**

• Desktop-based Silent Monitoring/Recording does not work and is not supported. (Silent Monitor—for both CTI OS and Cisco Agent Desktop—is not supported with Network Address Translation.)

• Remote supervisors are only supported for the Remote Agent with IP Phone.

**Network limitations**

• Network Address Translation (NAT) is supported when Unified CCE Remote Agent Option is used with the Cisco Business Ready Teleworker Model. Design guides for Business Ready Teleworker can be found at:
  * [http://www.cisco.com/go/teleworker](http://www.cisco.com/go/teleworker)
  * [http://www.cisco.com/go/v3pn](http://www.cisco.com/go/v3pn)
  * [http://www.cisco.com/go/srnd](http://www.cisco.com/go/srnd)

• Routing through a Cisco 800 Series Router with Firewall enabled is supported.

• The G.729 codec is not supported for software conference bridges. Voice quality might degrade when the remote agent IP Phone is configured using a G.729 codec and an agent enters a Unified CM software conference bridge. The conference bridge must be configured on a DSP hardware device. There is no loss of conference voice quality using a DSP conference bridge.

  **Note** Use this solution even for pure IP telephony deployments.

• The Unified CCE server recognizes failures when the remote agent desktop or connection breaks. It stops routing calls to that agent until an agent logs back in and goes to a ready call state. Callers are routed to other available agents.

• The only traffic that is marked for priority AF31 from the desktop is voice. CTI traffic and Desktop Application traffic is not marked. Voice gets the priority. CRM Desktops like Siebel and Oracle are
supported; however, Silent Monitoring and Recording is not supported for CRM Desktops such as Siebel, Oracle, and so forth. Silent Monitoring, both Desktop based and SPAN Port based, is not supported with CRM Desktops and does not work.

- Do not use soft VPN clients to establish VPN connectivity for remote agents with IP Phones. VPN connection has to be set up using hardware-based VPN through a 8xx Series Router.

- If the remote agent PC modem is down or the connection goes down, Unified ICME software via CTI/Cisco Agent Desktop/CTI OS server recognizes the failure and stops routing calls to that agent, until an agent logs back in again, and goes to a ready call state.

- If the ADSL/Cable delay is greater than the maximum, the IPCC application encounters longer application response times.

Security limitations

- Wireless access points are supported; however, determine their use by the enterprise security policies of the customer. Wireless use does not affect remote agent performance because the bandwidth that wireless supports is greater than the broadband link.

Note

7920 Wireless IP Phones are not supported.

- This solution has only been tested with centralized Unified CCE and Unified CM Clusters.

Reporting limitations

- No special reports exist for individual remote agents. Unified CCE reports as they pertain to a Headquarter Contact Center are applicable.

- Real Time reporting, Historical reporting, and the monitoring of desktop queue statistics are not supported.
CHAPTER 11

Sample Cisco IOS configuration for analog FXO to PRI gateway

The following section provides a sample Cisco IOS configuration for an analog FXO to PRI gateway.

```
hostname pri-fxo-gateway
!
  isdn switch-type primary-ni
  controller T1 3/0
  framing esf
  linecode b8zs
  cablelength short 133
  pri-group timeslots 1-24
  !
  interface Serial3/0:23
  bandwidth 230400
  no ip address
  encapsulation hdlc
  no logging event link-status
  isdn switch-type primary-ni
  isdn incoming-voice voice
  no cdp enable
  !
  voice-port 1/0/0
  connection plar opx 4085551234
  !
  voice-port 1/0/1
  connection plar opx 4085551235
  !
  dial-peer cor custom
  !
  dial-peer voice 1 pots
  destination-pattern 4085551234
  no digit-strip
  port 3/0:23
  !
  dial-peer voice 100 pots
  destination-pattern 4085551235
  no digit-strip
  port 3/0:23
  !
end
```
INDEX

A

Agent 5
log in flexibility 5
Agent Desk Settings 26
configuring 26
Agent guidelines 39, 44, 76, 78, 83
limitations 83
using the CAD Desktop (Mobile Agent) 44
using the CAD Desktop (Remote Agent) 78
using the CTI OS Agent Desktop (Mobile Agent) 39
using the CTI Toolkit Agent Desktop (Remote Agent) 76
Agent profiles 28
CTI OS Server 28
Agent tasks (CAD Desktop) 44, 46, 47, 78
accepting calls 78
entering Ready state 46
initiating conference call 78
logging in 78
logging on 44
making calls 46, 78
making conference call 47
transferring a call 78
transferring calls 47
verifying login 46
Agent tasks (CTI Desktop) 40, 41, 42, 43, 76
accepting calls 76
enabling ring tone 41
entering Ready state 42
initiating conference call 76
logging in 40, 76
making calls 42, 76
making conference call 43
making conference transfer calls 43
performing conference transfer 76
verifying login 41
verifying successful login 76
Analog phone 64, 66, 71, 73, 82
call flow with Remote Agent 66
classification 73
configuration guidelines 71
configuring Remote Agent 71

Analog phone (continued)
network requirements for Remote Agent 73
system configuration with Remote Agent 71
validating installation and configuration of Remote Agent 82
working with Remote Agent 64

B

Business Ready Teleworker 62
architecture, working with Remote Agent 62
components 62

C

CAD desktops 39, 75, 78
availability with Mobile Agent 39
availability with Remote Agent 75
using with Remote Agent 78
CAD Desktops 44
using with Mobile Agent 44
call by call 5, 6
call flow 6
Call control 10
feature support 10
Call delivery mode 26
configuring 26
Call delivery modes 6, 7
Agent chooses 6
call by call 6
nailed connection 7
Call flow 14, 15, 16, 17, 18, 19
inbound calls 15
local consult calls 16
Outbound Option calls 19
overview 14
remote conference calls 18
remote consult calls 17
Call flows 65, 66
analog phone 66
Call flows (continued)

IP Phone 65

CallManager 22
  configuring CTI Port Pools 22

codecs 10
  feature support 10

Codecs 12
  important considerations 12

Components, Remote Agent primary 62

conference requirements 10

Configuration tasks 21

Configuring 22, 26, 28, 69, 71
  Agent Desk Settings 26
  CTI Port Pools 22
  Mobile Agent on CTI OS 28
  Remote Agent with analog phone 71
  Remote Agent with IP Phone 69

Connect tone 33, 34
  enabling 33

Connect Tone 7
  features 7

connection modes 5, 7
  call by call 5
  nailed connection 7

CTI desktops 39, 75
  availability with Mobile Agent 39
  availability with Remote Agent 75

CTI Object Server (CTI OS) 28
  agent profiles 28
  configuring Mobile Agent 28
  IdleTimeout key 28
  RejectIfAlreadyLoggedln key 28

CTI OS Agent Desktop 39
  using with Mobile Agent 39

CTI OS Server 28, 29, 34
  Agent profiles 28
  Installation 28
  Mobile Agent connect tone 34
  prevent duplicate logins to the same agentID 29

CTI port 5
  DN 5

CTI Port 10, 22
  configuring 22
  requirements 10

CTI Port Pools 24
  Music on Hold (MoH) 24

CTI Toolkit Agent Desktop 76
  using with Remote Agent 76

D

Desktops 39, 75
  available with Mobile Agent 39
  available with Remote Agent 75

Device Targets (Configure ICM) 28
  configuring Mobile Agent 28

F

Failover 12
  important considerations 12

Fault tolerance 11

Feature support 10
  call control 10
  codecs 10
  IVR 10
  multichannel 10
  outbound calls 10
  silent monitoring 10

G

Guidelines 69, 71
  configuration, with analog phone 71
  configuration, with IP Phone 69

H

Hardware setup 82

I

Important considerations 12, 13
  codecs 12
  failover 12
  performance 12
  silent monitoring 13

Inbound call flow 15

Installation 28
  CTI OS Server 28

IP Phone 63, 65, 69, 70, 81
  call flow with Remote Agent 65
  compatibility 70
  configuration guidelines 69
  configuring Remote Agent 69
  network requirements for Remote Agent 70
  system configuration with Remote Agent 69
IP Phone (continued)
  validating installation and configuration of Remote Agent 81
  working with Remote Agent 63
IPCC solution 62
  components 62
  working with Remote Agent 62
IVR 10
  feature support 10

L
Limitations 83, 84, 85
  agent 83
  network 84
  reporting 85
  security 85
  supervisor 84
local agent, defined 3
Local consult calls 16
Logout non-activity time 26
  configuring 26

M
Mobile Agent 3, 9, 10, 13, 14, 20, 21, 22, 34, 39
  conference requirements 10
  configuration tasks 21
  CTI Ports requirements 10
  enable connect tone 34
  hardware requirements 9
  limitations 14
  Mobile Agent Scalability 13
  overview 3
  performance and optimization 22
  phone requirements 10
  reporting 20
  unsupported features 14
  user information 39
  multichannel 10
  feature support 10
Music on Hold (MoH) 24
  CTI Port configuration 24

N
nailed connection 5, 34
  Mobile Agent connect tone 34
Nailed connection 7
  call flow 7

Network 70, 73, 84
  limitations 84
  requirements for Remote Agent with analog phone 73
  requirements for Remote Agent with IP Phone 70

O
Optimization 22
  Outbound calls 10
    feature support 10
  Outbound Option 19
    call flow 19

P
Performance 12, 22
  important considerations 12
  phone requirements 10

R
Remote Agent 3, 61, 62, 63, 64, 65, 66, 69, 71, 75
  call flow with analog phone 66
  call flow with IP Phone 65
  defined 3
  description 61
  primary components 62
  system configuration with analog phone 71
  system configuration with IP Phone 69
  user information 75
  with Cisco Business Ready Teleworker architecture 62
  with IPCC solution 62
  working with analog phone 64
  working with IP Phone 63
Remote conference call 18
Remote consult calls 17
Reporting 20, 85
  limitations 85
  Mobile Agent 20
RONA time 26
  configuring 26

S
Security 85
  limitations 85
Silent monitoring 10
  feature support 10
Silent Monitoring 13
  important considerations 13
Supervisor 84
  limitations 84
Supervisor tasks (CAD Desktop) 56
  logging on 56
  viewing Mobile Agent 56
Supervisor tasks (CAD Supervisor Desktop) 56
Supervisor tasks (CTI Desktop) 54, 55
  configuring a Mobile Agent 55
  logging in 54
  silent monitoring and recording. 55
  verifying login 55
Supervisor tasks (CTI OS Supervisor Desktop) 53

U
Using 39, 44, 76, 78
  CAD Desktop (Mobile Agent) 44
  CAD Desktop (Remote Agent) 78
  CTI OS Agent Desktop (Mobile Agent) 39
  CTI Toolkit Agent Desktop (Remote Agent) 76

V
Validating 81, 82
  installation and configuration of Remote Agent with analog phone 82
  installation and configuration of Remote Agent with IP Phone 81